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Chapter 1: Requirement to Deploy Value Stream
Concepts
This chapter includes:

Overview 11

Requirement to Deploy Value Stream Objectives 14

Requirement to Deploy Value Stream Diagram 16

Requirement to Deploy Functional Components 17

Overview
The Requirement to Deploy (R2D) Value Stream provides a prescription for the key service life cycle
data artifacts that IT needs to closely manage and define, build, test, and deploy an IT service. By
understanding these artifacts and implementing the relationships between them, IT is finally equipped
to control the quality, utility, schedule, cost, and sourcing of any aspect of a service that the business
requests.

To accomplish this, the R2D Value Stream provides the framework for creating and sourcing a new
service or modifying an existing service. The R2D Value Stream is initiated when it receives a demand
signal from the business in the form of an approved IT contract and conceptual service blueprint from
the Strategy to Portfolio (S2P) Value Stream. The R2D Value Stream ends when the requested service
or modification is either deployed into production or packaged for future deployment through a Request
to Fulfill (R2F) Value Stream catalog request.

The key inputs for the R2D Value Stream are:

l IT contracts, which originate from the business and are an output of the S2P Value Stream as a
result of its Proposal Management function

l Conceptual service blueprints, which are generated from the S2P Value Stream Service Portfolio
Management Functional Component

l Requirements, which are generated from the S2P Value Stream DemandManagement Functional
Component

l Policies and standards, which originate from the S2P Value Stream Policy Management
Functional Component where the growing body of guidelines and best practice requirements are
captured from IT and the business

The inputs above are assessed, rationalized, and elaborated with more detail and ultimately become
content that is consumed and produced and passed on in the R2D Value Stream.
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Note: For deployment and configuration instructions, see Part III:Requirement to Deploy
Configuration Guide.

Who Should Read This Guide

This guide explains themotivation to install and use the Requirement to Deploy Value Stream. It
describes what the value stream implementation will achieve and describes the workflow between the
products that comprise the value stream.

This guide is intended for:

l Project managers

l IT architects

l Developers

l Deployment technicians

l Quality engineers

l Release managers

l Presales and sales personnel

l PSO

l Anyone whowants to learn about a framework for creating, modifying, or sourcing a service

The information in this guidemay duplicate information available in other Value Stream documentation,
but is provided here for convenience.

Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on the HP Software
Support web site where you can search the Self-solve knowledge base. ChooseHelp >
Troubleshooting & Knowledge Base. The URL for this web site is
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support web site. This site enables you to browse
the Self-solve knowledge base. You can also post to and search user discussion forums, submit
support requests, download patches and updated documentation, andmore. ChooseHelp >
HP Software Support. The URL for this web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract.

To findmore information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp
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To register for an HP Passport user ID, go to:
http://h20229.www2.hp.com/passport-registration.html.

HP Software Web site accesses the HP SoftwareWeb site. This site provides you with themost up-
to-date information on HP Software products. This includes new software releases, seminars and trade
shows, customer support, andmore. ChooseHelp > HP Software Web site. The URL for this Web
site is www.hp.com/go/software.

Requirement to Deploy Concept and Configuration Guide
Chapter 1: Requirement to Deploy Value Stream Concepts

HP Value Stream (2.1) Page 13 of 256

http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software


Requirement to Deploy Value Stream Objectives
IT departments today experience challenges inmeeting the expectations of the business in planning,
developing, and delivering requested services. The R2D Value Stream is designed to ensure
predictable, cost-effective, high quality results to the business while also promoting high levels of
re-use, flexibility, agility, and collaboration across IT to support traditional and new methods for service
creation and sourcing.

Key objectives tomeet in support of giving the business what it needs are to:

l Make service delivery predictable, even across globally dispersed teams, multiple
suppliers, and multiple development methodologies

Services today are sourced or developed in cooperation with many different parties or
configurations. All parties are working with their own processes and tooling. IT must be able to
provide a good overview of the planned activities, should speak a common language with all parties
involved, and should provide amethodology for how to achieve the best quality.

Cloud sourcing, Agile development, and other innovations have created the need for IT to be able to
manage development and delivery of services in a hybrid environment. IT needs an R2D Value
Stream framework that can accommodate everything, including:

n contracts for SaaS/subscription services

n fast, lightweight application releases, such as mobile applications or those built using Agile
methodologies (for example SCRUM, extreme programming)

n traditional applications that utilize more structured project-driven release cycles

n everything in between

l Ensure that each service release is high quality and fit for purpose, and meets customer
expectations

IT still experiences toomany incidents immediately after release of a service into production. IT
must establish control over the quality of a service regardless of the number of vendors that are part
of the delivery.

l Optimize time spent on planning to drive predictability of delivery time, as well as
accuracy to ensure the business gets what it asked for when it asked for it

Poor estimates at the start of an IT project on elements such as estimates for service design,
development, and delivery ensuremissing the delivery schedule later. Better estimates help drive
better trends for "on-time delivery," but must be balanced with pressures of "Agile methods" and
"continuous delivery" that shorten planning and development windows. When tracked and
optimized, the trends on plan versus estimate from the cycles of the R2D Value Stream
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plan/design/deliver can be used by the Strategy to Portfolio Value Stream for continuous
improvement.

l Standardize service development and delivery to the point where re-use of service
components is the norm

IT continues to struggle to find ways to increase the quality and speed of service delivery while also
lowering costs. In support of these efficiency and quality goals, IT must have a framework in which
to drive the re-use of existing service components at multiple stages of the development life cycle
across multiple services. IT must work successfully with multiple internal and external contributors
and be able to integrate the data process and tools required to work with globally dispersed teams,
outsourcers, traditional and Cloud-based suppliers. Furthermore, IT must maintain control of the
governance of this service delivery value stream and be able to track andmeasure internal and
vendor performance, costs, quality, and on-time delivery. The ability to re-use requirements, source
code, documentation, test scripts, servicemonitors, and other artifacts of the service development
life cycle is a key contributor to managing cost, increasing quality and predictability, and
accelerating release cycles.

l Build a culture of collaboration between IT Operations and IT Development to support
service release success

Both IT Development and IT Operations are paying a price for the poor collaboration that is the norm
inmany IT departments. Development organizations build and test services in a silo and surprise IT
Operations by “throwing release packages over the fence” for immediate delivery. IT Operations
may not manage the IT infrastructure to adapt for new standards and environments fast enough to
meet the requirements of new developments from the Service Design and Development team. IT
must make clear the role of IT Operations in the R2D Value Stream life cycle such that
requirements and inputs from both sides are received at each stage of the service life cycle.

l Put rigorous structure in place to lessen the impact of the IT reality – high staff turnover

High turnover in IT means knowledge is lost and schedules are impacted—particularly in low cost
labor markets where employers are suffering high employee turnover rates. The R2D Value Stream
helps capture the knowledge that would otherwise be lost and cause schedules to be delayed.

l Drive predictable outcomes without driving out innovation

Innovation and process efficiency are two pillars of competitive advantage that IT departments
bring to the business, yet these two pillars often have trouble co-existing. The emphasis on on-time
project delivery tends to stifle innovation, creating a conflict between these two priorities. IT must
continuously improve its ability to execute in such a way that on-time innovation is the norm. The
R2D Value Stream identifies the core automation enablers and the key data exchanges required to
accomplish this goal. For example, focusing efforts on automation of test, release, and deployment
provides more time and resource for innovation in service design and development.
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Requirement to Deploy Value Stream Diagram
The following diagram illustrates the Functional Components and Artifacts that comprise the Requirement to Deploy Value Stream as described
in version 1.2 of Reference Architecture.
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Requirement to Deploy Functional Components
The following functional components support the definition, development, and governance of the
artifacts and servicemodel entities utilized in the R2D Value Stream:

l Project. Receive IT contracts, coordinate the creation, and provide ongoing execution oversight of
IT Projects aimed at the creation of new or enhancements to existing IT services.

l Requirements.Manage requirements through the life cycle of the service. Maintain traceability of
each requirement to the original request that generated the demand throughout the service life
cycle. Collect, refine, scope, and track progress of requirements.

l Service Design. Create the logical service blueprint and service design technical specifications for
the service(s). Ensure thesemeet the requirements from the IT Contract, IT Project and/or demand,
andmake it perform against the Key Performance Indicators (KPIs), Key Risk Indicators (KRIs)
and Service Level Agreements (SLAs). The output of the Service Design Functional Component is
used by the Service Development Functional Component to guide, source, create, and secure the
service.

l Service Development. Ensure that the service is developed in accordance with design
specifications, organizational policies and standards, and both functional and non-functional
requirements, so that the service can be operated successfully and in line with customer
expectations and requirements. Produce andmanage source and documentation that is stored in
the definitivemedia library (DML).

l Build. Create, manage, secure, and track builds. Implement build automation. Manage the delivery
of builds to Release Design Functional Component. Maintain builds in the DML.

l Release Design.Manage the service release, release packages, and service release blueprints for
developing and delivering new or changed services into production, and facilitate a smooth
transition to IT operations. Ensure the appropriate security measures (based on the risk posture of
the service) are part of plan.

l Test. Plan and execute tests which ensure that the service will support the customer’s
requirements at the agreed service levels, including system/integration testing, user acceptance
testing, performance testing, and load testing.

l Defect. Keep track of all defects, including their origin, status, importance, and relation to
requirements and known errors.

l Change Control. Ensure standardized, auditable methods and procedures, with efficient and
prompt handling of all changes tomitigate business risk andminimize impact.

The R2D Value Stream is process agnostic in that while methods and processes may change—for
example, Agile, Waterfall, ITIL, Cobit, and so on—the functional components and data artifacts that
comprise the value stream remain constant.
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Requirement to Deploy Artifacts

The Requirement to Deploy Value Stream contains both key and auxiliary artifacts that interact with the
configuration items that comprise the physical servicemodel.

The artifacts for this value stream are:

l Build. A build is the activity of assembling a number of configuration items to create part of an IT
service. The term is also used to refer to a release that is authorized for distribution—for example,
software build, server build, or laptop build. The build is part of the release package.

l Defect. A defect is a flaw in a component or system that can cause the component or system to fail
to perform its required function, such as an incorrect statement or data definition. A defect, if
encountered during execution, may cause a failure of the component or system.

l IT Project. An IT Project is a temporary endeavor with a defined beginning and end, undertaken to
achieve an objective or outcome at a certain cost. In the context of this reference architecture, the
typical project outcome is the delivery of a new service or modification of an existing service or
application.

l Logical Service Blueprint. A logical service blueprint provides the structure, behavior, and design
for the components that make up a new or changed service and describes how those components
relate to one another. The logical service blueprint can be thought of as what is traditionally
expressed in IT terms as the design. The logical service blueprint, together with the service release
and service release blueprint, make up the logical servicemodel.

l Requirement. A requirement is a formal statement of what is needed. Such a statement identifies a
necessary attribute, capability, characteristic, or quality of a system for it to have value and utility to
a user. Requirements aremanaged throughout the life of an IT service, not just through the duration
of an IT Project. Requirements are increasingly framed as use cases, user stories, scenarios, or
similar concepts and, rather than always in large “batches,” may move independently through the
R2D pipeline.

l Release Package. A release package is a collection of one or more builds, together with a service
release blueprint, which describes how these builds can be deployed (as one build for the
application server, one build for the database, and one for the front end). The release package is the
collection of the builds and service release blueprint which shows how this can be deployed in
various infrastructure environments. A release packagemight also contain other release objects
that are not the result of a build process, such as trainingmaterial, known errors, or run books.

l Request for Change. A request for change (RFC) is a formal proposal for a change to bemade. It
includes details of the proposed change, andmay be recorded on paper or electronically. An RFC is
an artifact that describes the intended addition, modification, or removal of anything that could have
an effect on IT services. The scope should include all IT services, configuration items, processes,
and documentation. Its intention is to make sure that anything that is needed is tracked tominimize
the risk in operations.

l Service Design Package. The design package provides the necessary details that describe the
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design of the IT service—at least sufficient to a given stage in its development. It may be iteratively
refined.

l Service Release. The service release describes the characteristics associated with a specific
release of a service. The service release not only contains the blueprints and packages, but also the
support components of a release; such as value delivery chain activities, training, and
documentation.

l Service Release Blueprint. A service release blueprint provides the description and procedures in
order to activate, deploy, and operate a service and its underlying components, including
applications and technology.

l Source. Represents all kinds of sources used within the build process or packaged into a build to
make up an application or service. This may include, but is not limited to: build scripts, configuration
files, localization files, code in programming languages, code of monitors, HTML, CSS, and
JavaScript.

l Test Case. A test case is one or a set of test cases which contain a set of input values, execution
preconditions, expected results and execution post conditions, developed for a particular objective
or test condition, such as to exercise a particular program path or to verify compliance with a
specific requirement. A test case is developed based on a requirement or a defect, and the same
test case can be applied across many releases.
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Chapter 2: Requirement to Deploy Use Cases
This chapter includes:

Overview 21

Generic End-to-End Service Development Use Case 21

DevOps Use Cases 33

Overview
The use cases in this document describe the Requirement to Deploy Value Stream, which covers
planning and designing a new ormodified service, through development and testing, to release and
deployment.

Generic End-to-End Service Development Use Case
This section contains the following topics:

Overview 21

Use Case Diagram 22

Use Case Steps 22

Example: Delivering New Mobile Employee ExpenseManagement Service 23

Overview

TheGeneric End-to-End Service Development Use Case illustrates the creation of a new service or
modification of an existing one. The use case starts with the creation of a project; goes through service
design, development and testing; and ends with releasing new content.
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Use Case Diagram

The following diagram provides a high level data flow for a generic end-to-end service development use
case of the Requirement to Deploy Value Stream.

Use Case Steps

1. Project Manager receives IT contract and creates an IT Project. Creates corresponding
Development Project/Releases. Specifications captured in the original project forwarded to
Requirements Management system—preserving a link to enable review of the requirements
status and progress at the project level.

2. Project Manager submits a request for change (RFC) for each service release. The RFC goes
through the normal change process until approval.

3. Business Analyst logs requirements linked to Business Services. Refines and updates existing
requirements; prioritizes.

4. IT Architect receives IT contract, conceptual service, and related requirements. Creates a logical
service blueprint for new/modified service. Associates logical service blueprint with conceptual
service, corresponding requirements, release entities, and design specifications.

5. Developer develops according to design specifications, includingmonitors. Manages source
code.

6. Build Manager produces builds and runs unit testing. Automatically provisions and runs
integration, performance, and user interface tests.

7. Tester creates test plan and defines manual and automated tests, executes tests, and logs
defects. Defects considered as known errors published in the KnowledgeManagement system.
Tests linked to the requirements. Status and progress can be reported in the release level and the
project level.

8. ReleaseManager tracks release progress, defines dependencies between releases, and
assembles all release artifacts—deployment model, build artifacts, monitor templates,
documentation, known errors, training assets, maintenance scripts, and so on. Defines schedule
for deployment into production.
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9. Deployment Manager deploys new release to production, including:

n Monitors

n Known errors to the knowledge base

n Documentation and training assessment

n New catalog entry (when relevant) and creates configuration items (CIs) in the CMDB for each
instantiation

n Updates the Service Portfolio with the status of the new available service

n Updates the Request for Change

Example: Delivering New Mobile Employee Expense Management
Service

The Deliver New Mobile Employee ExpenseManagement Service is a real life example of the generic
use case. It describes the service life cycle from the early planning phases until the delivery phase.

This section contains the following topics:

Overview 23

New Mobile Employee ExpenseManagement Service Diagram 24

Delivering the New Mobile Employee ExpenseManagement Service 24

Overview

An Enterprise IT organization is delivering a new business service. To achieve this, a project needs to
be created, planned, and executed. This includes defining andmanaging the project tasks, budgets,
and schedules; developing the appropriate service components in accordance with business
requirements; and deploying them to designated environments.
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New Mobile Employee Expense Management Service Diagram

Delivering the New Mobile Employee Expense Management Service

The service that is implemented is a new ExpenseManagement service for employees, accessible
frommobile devices. It is an IT service composed of several business applications—iOS and Android
clients for supportingmobile device users, and application back end for management and
administration. In addition, non-software components are needed to enable service operation; namely,
knowledge briefs, known errors data for support personnel, and training videos for end users. The
service also depends on two other services—an Employee Authentication Service and a SAP system
with an expense trackingmodule.

This section contains the following steps:

Step 1: Project Initiation 25

Step 2: Service Design 25

Step 3: Release Planning 26

Step 4: Developing the Applications 28

Step 5: Deploying the Service 30
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Step 1: Project Initiation

Step 1 creates andmanages the project for the EEM service implementation—as preparation for the
development stage.

First, the Project Manager takes the lead by creating the new project in the HP Project and Portfolio
Management (PPM) Suite. The project is based on an IT contract for an ExpenseManagement service.
That IT contract is thewhat of the service release and contains requirements, boundaries, resources,
schedules, and so on. The project contains several tasks for project planning, application development,
service deployment, and other activities.

After defining the tasks that require a change process for their implementation, the Project Manager
creates requests for change (RFCs) in HP ServiceManager (SM). At this stage, the required RFCs for
this implementation are reviewed and the appropriate teams start working on them. As a result, the
RFCs can be approved before the development is completed, thus avoiding delays in the deployment.

The RFCs contain a reference to the PPM Project, which allows the ChangeManager to review a list of
all changes created for the EEM development project simply by filtering. This is possible with the
PPM – SM Integration ID#255 "Creating an SM RFC from PPM Project Task" on page 207.

Step 2: Service Design

Architects are creating a design for the EEM service based on an IT contract and associated
requirements. The service is modeled using Enterprise Architecture tools, and this model is exported to
UCMDB. UCMDB-PPM andUCMDB-SM integrations allow using this model as unified service
context in PPM and SM.
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The results of these actions are:

l a design of the EEM servicemodeled in UCMDB

l a project in PPM detailing the tasks and resources needed for successful EEM service
implementation, with the SM RFCs that are related to the PPM project already in progress

Step 3: Release Planning

Step 3 covers the elaboration of requirements, assigning the requirements to appropriate application
releases, and enabling tracking project progress.

In our example, the EEM service is comprised of three applications that need to be developed—the iOS
client, Android client, and the back-endmanagement application.

Different teams work on the development of each application, thus enabling different methodologies to
be used. The EEM service components are developed either in Agile or in a classically developed
fashion.

The iOS and Android client applications are developed using the Agile methodology, thus the releases
of these applications aremanaged in Agile Manager.
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On the other hand, the back-end application is developed using classic methodology, and its releases
aremanaged in ALM.

In the PPM project, the development tasks are linked to both Agile Manager and ALM releases. This
allows users to obtain release data and quality information directly from the PPM user interface.

The following integrations make this linkage possible:

l PPM –ALM ID#633 integration. For more information, see "Viewing ALMQuality Metrics in PPM"
on page 72.

The following screen shot shows project task details with the focus on theQuality tab. In this
screen shot, the tab shows defect summary graphs for a specific release linked to the task.

l PPM –AgM ID#634 integration. For more information, see "Viewing Agile Manager Release
Information in PPM" on page 183.

The following screen shot shows a project task linked to an Agile Manager release. The sprint
details are synchronized automatically.
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Requirements logged by the business analyst are elaborated and enriched, and assigned to the
appropriate releases in ALM (for the back-end application) and Agile Manager (for client-side
applications). The requirements and user stories define the action items for the development teams.

It is important to ensure the requirements are being created, prioritized, and linked to an appropriate
application release.

During the work on requirements, Agile Manager and ALM tools are integrated and synchronized to
allow information to exist in the ALM application for the advanced testing capabilities it provides.

The outcome of this step is:

l PPM project tasks are linked to the appropriate application releases.

l Requirements and user stories that define the application releases are elaborated and prioritized.

Step 4: Developing the Applications

Developers work on implementing the requirements and user stories from Agile Manager and ALM,
while developing the three EEM service applications. When working on the source code, developers
use HP Application Lifecycle Intelligence (ALI) capabilities to attach source code changes to
appropriate context either in ALM or Agile Manager. The use of ALI enables developers to review the
source code changes in the context of implemented user stories or fixed defects, thus enhancing the
clarity of the development process.

l List of code changes linked to Requirements or Defects in ALM

Requirement to Deploy Concept and Configuration Guide
Chapter 2: Requirement to Deploy Use Cases

HP Value Stream (2.1) Page 28 of 256



l List of code changes linked to User Stories, Defects or Tasks in Agile Manager

The build server compiles the applications so that planned testing activities on the specific build
(manual and automatic) can begin. ALI allows build results to be viewed and shows details directly from
ALM or Agile Manager. In addition, the tests and defects that are opened are linked to the specific build.

The deployment process becomes increasingly more complex and time consuming. Therefore, Codar
is implemented to integrate with the build system, automatically provision the environment, and deploy
build results. This enables the development and testing teams to commence with verifying that the
software is being built according to a defined quality standard. When the testing on various levels is
complete, a decision is made to promote the software build further through the release pipeline as it
goes throughmore andmore thorough testing types.

In this phase, defects are reported in ALM. Some of these defects are fixed in future builds, while
others are published as known errors to SM for Help Desk agents to be aware of.

In parallel with managing the development of the applications related to the EEM service, work is being
done to provide additional content that is also a part of the EEM service. Training videos are being
created, help desk documentation is being written, and a set of known errors is being gathered and
published in SM. These additions provide the necessary information for future users of the EEM service
in the organization.

The outcome of this phase is to have a build ready for deployment for all three applications, with some
defects and known errors that can be addressed in future releases.
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Step 5: Deploying the Service

Service deployment means to deploy all of the help desk documents, training videos, known errors, and
other components of the service, andmake them available to the users.

The business applications that the service depends on should be deployed to appropriate environments
when desired quality is achieved. Themost advanced phase is when the build is ready for deployment
to production. Depending on the nature of the application, it can end with either:

l a deployment to production environment using Codar, as in the case of the ExpenseManagement
web application

or
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l a publication to the IT service catalog where a service offering is created in CSA based on a Codar
design and end users can order it from the IT self-service portal—for instance, themobile client
applications for the ExpenseManagement system that the employees use

For more information, see HP Codar version 1.00 Concepts Guide.

The RFC for complete service deployment, which was created in the project planning stage, ensures
that the approvals from the necessary personas are there before the deployment occurs. Then after it is
implemented, all components of the service—both software and non-software—are in place. The
UCMDB is updated with new configuration items and relations when service components (such as
servers and applications) are discovered.
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The outcome of this final phase is that the new EEM service is deployed and operational. The
appropriate PPM project task for the deployment is updated with closure comments from the
implemented RFC, thus closing the feedback loop.
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DevOps Use Cases
The "Generic End-to-End Service Development Use Case" on page 21 focused on a complete service.
These use cases focus on parts of the complete service.

This section contains the following topics:

Overview 33

Build Software Use Case 33

Deploy Software to Dev/Test Use Case 36

Deploy Software to Staging/Production Use Case 39

Overview

The DevOps Use Cases illustrate how to develop and deploy software functionality from development
to operations in amaximally automatedmodel, with sustainable velocity and demonstrating effective
feedback.

Build Software Use Case

This section contains the following topics:

Use Case Steps 33

Example: Building Software 34

Use Case Steps

1. Developer checks in code to theSource Control Management system.

2. This triggers the workflow to start the new build. This may be done immediately or on a batch
basis (that is, the nightly build).

3. TheBuild Management system, performing a continuous integration, runs tests which include
unit tests, as well as external static analysis.

4. Test executionmay result in defects being logged.

5. If the build succeeds, the built package is stored in a package repository.
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Example: Building Software

This example covers a web application for an ExpenseManagement system that is used by payroll
employees to review and approve expenses submitted by employees from their mobile devices.

To develop and build the web application for the Employee Expense Management
system:

1. Developer reviews development task and implements a requirement and/or fixes a defect in their
integrated development environment (IDE). Integration of IDE and ALM or Agile Manager allows
review and update of the requirements/defects/tasks from within the IDE.

2. Modified code is committed to the Source CodeManagement (SCM) with an appropriate commit
message, which enables linking the code change to a specific defect/requirement (for ALM) or
development task (for Agile Manager).

The following screen shot shows a commit message by the developer.
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3. Each night a build job is triggered automatically—pulling the latest source code from SCM and
building the web application.

4. Basic tests, such as unit tests, are executed and, if successful, the build is stored in an artifact
repository such as Nexus, as shown in the following screen shot:
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Deploy Software to Dev/Test Use Case

This section contains the following topics:

Use Case Steps 36

Example: Deploying Software to Dev/Test 36

Use Case Steps

1. TheDeployment process is initiatedmanually or automatically—for example, from a successful
build.

2. The built package is pulled from the package repository and applied to the target system.

3. (Optional) Monitors are also deployed.

4. Developer or tester executes tests against the target system.

5. Test executionmay result in defects being logged.

Example: Deploying Software to Dev/Test

Continuing from "Example: Building Software" on page 34, the development teammodifies the source
code, which results in a new build being created and ready for additional testing at varying depth levels.
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To deploy the software to dev/test:

1. During the initial phases of the project, application architect uses Codar to create the design for
application deployment, which will be used to deploy the application builds automatically.

2. Build manager configures Jenkins plug-in for Codar, to create a new build package for the
ExpenseManagement web application when a new build is completed successfully, and to deploy
it on a Development environment.
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3. Members of the testing team can use Codar to deploy additional environments of the same build,
and use those to execute different types of tests (functional, performance, and others). ALM
integrations with several testing tools—such as UFT for functional testing and PC for performance
testing—are leveraged to test the software from different perspectives.

4. As part of preparation for production, HP Unified Functional Testing (UFT) tests that were used for
testing can be reused (with modifications) as HP Business Process Monitor (BPM) scripts to
monitor the application behavior.
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5. As tests are written based on specific requirements, their execution affects the requirements
coverage, as illustrated in the following Requirements CoverageGraph. Test execution results are
stored in ALM, and defects are logged accordingly.

Deploy Software to Staging/Production Use Case

This section contains the following topics:

Use Case Steps 39

Example: Deploying Software to Staging/Production 40

Use Case Steps

1. TheDeployment process is initiatedmanually or automatically—for example, from a successful
build.

2. A proposed change is submitted to theChange Control system.

Note: This may be a standard change and approved in an automatedmanner.
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3. Upon RFC approval, the built package is pulled from the package repository and applied to the
target system.

4. Monitors are deployed.

5. The CMDB is updated as required with any new configurations and dependencies or originating
from the packagemanifest.

6. In the staging phase, testers execute system-level, integration, and/or performance tests against
the target system.

7. In the staging phase, test executionmay result in defects being logged.

Example: Deploying Software to Staging/Production

The build package of the ExpenseManagement web application, which was tested extensively while in
the Testing phase, is ready to be deployed to the Staging environment.

To deploy software to staging/production:

1. QA manager approves that the build satisfies the quality requirements and the build package is
promoted to staging in Codar.
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AnRFC is submitted in HP ServiceManager (SM) and needs to be approved before the
deployment, which consumes substantial resources and affects the work of multiple teams.

2. When RFC is approved, the build package is deployed automatically on the Staging environment.

Usually this is the phase when User Acceptance Tests and Performance Tests are executed. In
addition, at this phase the automated deployment of monitors is tested to ensure that the
application will bemonitored appropriately from themoment it is deployed.
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3. Once all of the tests are complete on the staging environment, and the results are satisfactory,
preparation to production deployment begins:

a. An RFC is submitted in SM, reviewed, and approved.

b. The time window for change implementation is scheduled.

c. The build package is promoted to the Production phase in Codar.

d. Non-software components which accompany the release are prepared for distribution.

4. When the time to deploy the application to production comes, the automatic deployment is
triggered.

Once it is successfully completed:

n QA approves that all functions are operating normally,

n Operation's team confirms successful deployment of monitors,

n HP Universal CMDB (UCMDB) is updated with new configuration items and relations,

n RFC is updated and closed.
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Chapter 3: Requirement to Deploy Value Stream
Configurations
This chapter includes:

Overview 44

HP Products 45

HP Products and Related Integrations 47

Hardware and Software Requirements 48

HP Project and Portfolio Management – Overview 52

HP Application Lifecycle Management – Overview 52

HP ServiceManager – Overview 53

HP Universal CMDB –Overview 54

HP Agile Manager – Overview 54

HP Operations Orchestration –Overview 55

Overview
The balance of this guide provides the information necessary to implement the integrations needed to
achieve the preferred IT management ecosystem. The user decides how many configurations to
implement in order to achieve themanagement level required.

Feel free to use the entire solution, amix of the various products, or just use a single product to address
your management needs.

Note: Throughout this document, italicized text enclosed in angle brackets (for example, "<your_
server_name>") indicates replaceable text.
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HP Products
To utilize the complete end-to-end Requirement to Deploy Value Stream, the following products are
recommended. These products must be installed and fully functional. Although we recommend using
only HP tools, based on your requirements, you can use whatever products and integrations you want
or need—including any third-party tools of your choice.

Note: Subsets of the following products can also be used. Keep inmind that the functionality of
the Requirement to Deploy Value Stream is dependent on the products you choose to employ.

l HP Universal CMDB. Server is installed. Data flow probe is connected and running (different
server than HP Business ServiceManagement server).

l HP Application Lifecycle Management. Server, client, and synchronizer package are installed.

HP offers a wide array of testing tools that can be integrated with ALM to cover various aspects of
the testing process—for example:

n HP ALM Performance Center

n HP United Functional Testing

n HP Sprinter

n HP LoadRunner

l HP Service Manager. Server, Client, Web Tier, and KnowledgeManagement are installed and
running.

l HP Operations Orchestration. Central and Studio are installed and available for use.

l HP Project And Portfolio Management Center. Server is installed.

l HP Agile Manager. Agile Manager is managed by HP via a Software-as-a-Servicemodel.

l HP Business Service Management. Server is installed with EUMmodel enabled, and integrated
with SiteScope.

l HP SiteScope. Server is installed and integrated with BSM andCODAR.

Note: Third-party tools are used in this guide for example purposes only.
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Requirement to Deploy Value Stream Products and Functional Components

The following diagram illustrates themapping between the products and the functional components of the Requirement to Deploy Value Stream:
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HP Products and Related Integrations
The following diagram displays how HP Products integrate in the Requirement to Deploy Value Stream Reference Implementation:
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Hardware and Software Requirements
This section contains the following topics:

Supported Versions 48

Enterprise Hardware and Software Requirements 50

Additional Online Resources 51

Supported Versions

Note: For the hardware and software requirements, see the product documentation.

Product Version Instructions

Project and
Portfolio
Management

l 9.30 or later

Recommended. 9.30

For installation instructions, see the
HP Project and Portfolio Management
version 9.30 Installation and
Administration Guide.

Service
Manager

l 9.32 or later

Recommended. 9.32

Note: In this document, Service
Manager is installed with the
Process Designer Content
Pack. This is optional and is
available from HP Live
Network.

For installation instructions, see the
HP ServiceManager version 9.30
Interactive Installation Guide to install
version 9.30. Then upgrade to version 9.32
using the following guides:

l HP ServiceManager version 9.32
Release Notes

l Application Compatibility Matrix

Universal
CMDB

l 10.10 or later

Recommended. 10.10

For installation instructions, see the
HP Universal CMDB version 10.10
Interactive Deployment Guide.

Operations
Orchestration

l 10.02 or later

Recommended. 10.02

For installation instructions, see the
HP Operations Orchestration
version 10.02 Installation Guide.

Application
Lifecycle
Management

l 11.52 or later

Recommended. 12.01

For installation instructions, see the
HP Application LIfecycle Management
version 11.52 Installation installation and
Upgrade Guide.
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Product Version Instructions

HP Helion
Codar

l 1.00 or later

Recommended. 1.00

For installation instructions, see the
HP Helion Codar version 1.00 Installation
and Configuration Guide.

Business
Service
Management

l 9.24 or later

Recommended. 9.24

For installation instructions, see the
HP Business ServiceManagement
version 9.24 BSM Installation Guide.

SiteScope l 11.24 or later

Recommended. 11.24

For installation instructions, see the
HP SiteScope version 11.24 Deployment
Guide.

Note:

l HP Application Lifecycle Intelligence (ALI) supports third-party products such as Source
Code Management (SCM), Build Manager (BM), and Integrated Development Environment
(IDE). For more information, see theHP Application Lifecycle Intelligence version 2.7 User
Guide.

l Make sure that each application you install is up and running before you perform any
configuration steps.
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Enterprise Hardware and Software Requirements

Note: The following list details the deployment environments that have been rigorously tested
by HP quality assurance personnel.

For the complete listing of hardware and software requirements, see the relevant Support Matrix for
each product.

l HP Project and Portfolio Management. Formore information, see theHP Project and
Portfolio Management Center version 9.30 System Requirements and Compatibility Matrix for
PPM Center.

l HP Service Manager. Formore information, see theHP ServiceManager version 9.3x
Compatibility Matrix for SM Applications Contents andHP ServiceManager version 9.32
Support Matrix.

l HP Universal CMDB. Formore information, see theHP Universal CMDB version 10.10
Support Matrix.

l HP Operations Orchestration. Formore information, see theHP Operations Orchestration
version 10.02 System Requirements.

l HP Application Lifecycle Management. Formore information, see theHP Application
Lifecycle Management version 11.52 System Requirements.

l HP Helion Codar. Formore information, see theHP Helion Codar version 1.00 Support
Matrix.

l HP Business Service Management. Formore information, see theHP Business Service
Management version 9.24 BSM System Requirerments and Support Matrixes.

l HP SiteScope. Formore information, see the system requirements and support matrices in the
HP SiteScope version 11.24 Deployment Guide.
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Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on the HP Software
Support web site where you can search the Self-solve knowledge base. ChooseHelp >
Troubleshooting & Knowledge Base. The URL for this web site is
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support web site. This site enables you to browse
the Self-solve knowledge base. You can also post to and search user discussion forums, submit
support requests, download patches and updated documentation, andmore. ChooseHelp >
HP Software Support. The URL for this web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract.

To findmore information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:
http://h20229.www2.hp.com/passport-registration.html.

HP Software Web site accesses the HP SoftwareWeb site. This site provides you with themost up-
to-date information on HP Software products. This includes new software releases, seminars and trade
shows, customer support, andmore. ChooseHelp > HP Software Web site. The URL for this Web
site is www.hp.com/go/software.
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HP Project and Portfolio Management – Overview
HP Project and Portfolio Management (PPM) Center standardizes, manages, and captures the
execution of project and operational activities.

Most PPM Center users work in the standard user interface, which appears as a collection of
specializedWeb pages. These pages open in aWeb browser and offer you a customized view into
PPM Center. From these pages, you can run reports, submit requests, and create projects. You can
also view and use the PPMDashboard. The PPMDashboard is a real-timeWeb page view into your
PPM Center system. Using portlets, you can view important information about your work environment,
from the status of requests assigned to you to comparisons between current projects and staffing
profiles.

In addition to the standard user interface, some users require the PPMWorkbench to accomplish
certain tasks. Unlike theWeb pages, which open in aWeb browser, the PPMWorkbench opens in its
ownwindow. Designed for more advanced users, the PPMWorkbench is wheremuch of PPM Center
is configured. Configurators can use the PPMWorkbench to define workflows, create request types,
set up automatic notifications, as well as a host of other tasks and procedures.

HP Application Lifecycle Management – Overview
HP Application Lifecycle Management (ALM) empowers organizations tomanage the core application
life cycle, from requirements through deployment, granting application teams the crucial visibility and
collaboration needed for predictable, repeatable, and adaptable delivery of modern applications.

ALM simplifies and organizes applicationmanagement by providing you with systematic control over
the process. It helps you create a framework and foundation for your application life cycle management
workflow in a central repository.

HP Application Lifecycle Management provides:

l Release Tracking

ALM features a system for organizing and tracking application releases, enabling you to align your
business priorities and quality expectations with your project requirements, tests, and defects. ALM
helps youmakemore informed release decisions with real-time key performance indicators (KPIs).

l Requirements and Tests

ALM helps you define andmaintain a repository of requirements and tests. Requirements help
ensure that business and testing needs are covered. Tests can then be automatically generated
from these requirements to ensure the correct aspects of the application are being tested. Tomeet
the various goals of a project, you can organize the tests in your project into unique groups. ALM
provides amethod for scheduling and executing tests, collecting test results, and analyzing the
data.
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l Defects Tracking

Analyzing defects and defect trends helps youmake effective go/no-go decisions. ALM features a
system for tracking defects, enabling you tomonitor defects from initial detection until resolution. It
also allows you to share defects across projects, reducing risk by helping developers find, prioritize,
and resolve defects sooner. A centralized defect repository also enables reporting of aggregated
defect status and trends across projects.

l Analysis Tools

The ability to track progress throughout the application life cycle process is vital to predictability.
ALM provides tools for analyzing each phase of the process, including specific instrumentation for
Agile projects (for example, burn-up and burn-down charts). You can generate interactive graphs
that demonstrate a wide variety of business performance perspectives, or define reports with any
cross section of data. You can alsomonitor multiple business metrics by arrangingmultiple graphs
alongside each other in a single view.

l Asset Libraries

ALM supports sharing and reuse of asset libraries across projects. Sharable libraries help you
manage initiatives with multiple applications to verify that changes to one application do not
negatively impact another application. They also help to drive greater consistency and repeatability
by empowering asset reuse. Specific changes can be applied to the shared assets for each project
while allowing the library to maintain its integrity.

l ALM Integrations

ALM offers integration with HP tools (for example, Unified Functional Testing and LoadRunner) as
well as third-party and custom testing tools, and requirement and configurationmanagement tools.
ALM communicates with the testing tool of your choice, providing you with a complete solution to
fully automated application testing.

ALM supports you through all phases of managing the application life cycle. By integrating the tasks
involved in applicationmanagement, ALM enables you to better align IT with your business needs, and
optimize efficiency.

HP Service Manager – Overview
HP ServiceManager (SM) is a comprehensive and fully-integrated IT servicemanagement software
suite that enables you to improve service levels, balance resources, control costs, andmitigate risk
exposure to an organization. ServiceManager enables you tomanage services using a "life cycle"
approach, with consistent improvement built into the governancemodel.
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HP Universal CMDB – Overview
HP Universal CMDB (UCMDB) consists of a rich business-service-oriented datamodel with built-in
discovery of configuration items (CIs) and configuration item dependencies, visualization andmapping
of business services, and tracking of configuration changes.

UCMDB enables you tomanage all the CIs contained in amanaged world. A managed world refers to
any self-contained environment that can be described using a topology model (defined with HP’s
Topology Query Language (TQL)). For example, the IT infrastructure of a large business represents a
managed world, where the topology comprises multiple layers such as networks, protocols, databases,
operating systems, and so on. Youmanage views to view the information in exactly the format you
require.

Additionally, the information contained in the results of each TQL is updated automatically with the
latest data entering the configurationmanagement database (CMDB). As a result, once a TQL and
View have been defined, they continue to provide up-to-date information about the current state of your
managed world. Views appear in multi-level maps that enable you to identify key CIs, as required. You
can also create reports (in HTML, Excel, or table format) about information collected by the system.

HP Agile Manager – Overview
HP Agile Manager (AgM) is an Agile management solution for organizing, planning, and executing Agile
projects. It can support single teams ormultiple, geographically distributed teams across an enterprise.
Agile Manager provides:

l A drag-and-drop interface that enables easy release and sprint planning, task allocation, and
capacity management across teams and individuals

l Task and release planning boards that give all teammembers ready insight into the entire project
landscape, the flow of work, and potential issues or bottlenecks

l Real-time feedback on progress through highly customizable dashboards, metrics, and KPIs,
minimizing administration while increasing predictability

l Advanced development analytics that aggregate source code and build information to surface
meaningful insights into application changes, allowing for precise risk analysis andmore informed
decisions
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HP Operations Orchestration – Overview
HP Operations Orchestration (HP OO) is a system for creating and using actions in structured
sequences (called Ops flows, or flows) whichmaintain, troubleshoot, repair, and provision your IT
resources by:

l Checking the health of, diagnosing and repairing, networks, servers, services, software
applications and individual workstations

l Checking client, server, and virtual machines for needed software and updates, and, if needed,
performing the necessary installations, updates, and distributions

l Performing repetitive tasks, such as checking status on internal or external web site pages

The twomain components of HP OO are Central and Studio.

HP OO Central

This is a web-based interface in which you can:

l Run flows

l Administer the system

l Extract and analyze data resulting from the flow runs

HP OO Studio

This is a standalone authoring program in which you can:

l Create, modify, and test flows, including flows that run automatically, as scheduled

l Create new operations

You can create operations within Studio and run them in Central. You can also create operations
that execute outside of Central in a remote action service (RAS). You do so in a development
environment that is appropriate to the task, then associate the code you have created with an
operation that you create in Studio.

l Specify which levels of users are allowed to run various parts of flows
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Chapter 4: Creating ALM Requirement/Defect from
PPM Request
This chapter includes:

Overview 56

Setting up the PPM - ALM Configuration 57

Verification 70

Overview
This chapter describes how creating a request in the HP Project and Portfolio Management (PPM)
DemandManagement Module automatically creates a defect or requirement in the HP Quality Center
(QC) or HP Application Lifecycle Management (ALM) project with which the PPMCenter request type
is integrated. For example, a PPM Center request of typeDefect could create a defect in a Quality
Center or ALM project, whereas a PPMCenter request of typeRequestForChange (RFC) could
create a requirement in a Quality Center or ALM project.

In the context of the Requirement to Deploy (R2D) Value Stream, this integration enables receiving
inputs from the Strategy to Portfolio Value Stream in the form of requirements or defects.

For more information, see Integration ID#19: Application Lifecycle Management – RFC to
Requirement/Defect (PPM –QC) inHP Software Solutions Now.

The following diagram illustrates the relationship between the products for this integration:
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Setting up the PPM - ALM Configuration
This section contains the following:

Prerequisites 57

Configuring PPM Center 58

ConfiguringWorkflow for Request to Requirement Integration 66

Prerequisites

The following products must be installed:

1. PPM is installed with the ALM Content Bundle. If not, install the ALM content bundle on your
PPM.

For more information, see Chapter 2, "Installing and Setting Up ALM Content Bundle" in the
HP Project and Portfolio Management Center version 9.30 HP Solution Integrations Guide.

2. The ALM Connectivity Add-in file is running on the ALM server.

For more information, see Chapter 5, "Integrating PPM Center with HP Quality Center, Using ALM
> Configuring Integration with HP ALM Version 11.00 and Later > Installing the PPMCenter-ALM
Integration Tool (for HP ALM Version 11.50 and later) > Requirements for the PPMCenter-ALM
Integration Tool > Client-Side Requirements" in theHP Project and Portfolio Management Center
version 9.30 HP Solution Integrations Guide.

3. The PPMCenter-ALM Integration Tool is running on the PPM server.

For more information, see Chapter 5, "Integrating PPM Center with HP Quality Center, Using ALM
> Configuring Integration with HP ALM Version 11.00 and Later > Installing the PPMCenter-ALM
Integration Tool (for HP ALM Version 11.50 and later) > Download and Install the PPM Center-
ALM Integration Tool" in theHP Project and Portfolio Management Center version 9.30
HP Solution Integrations Guide.

Note: If the integration tool is not working, you canmanually add the fields to Quality Center. For
more information, seeHow to enable PPM related OOTB fields in QC project for ALM integration.
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Configuring PPM Center

To configure the PPM Center:

1. Log on to PPM Center with administrative privileges.

2. From themenu bar, select Open > Administration > Integration.

The Integration Configurations screen opens.

3. In the navigation pane, selectManage Application Change.

TheManage Application Change panel opens.

4. In theServer Configuration Details section, from theAdd Integration Configuration
drop-down list of available request types, select eitherALM – Defect Template with Quality
Center Integration orALM – Request for Change (RFC) Integration and click Add
Integration Configuration.

Complete the following tasks for each request type:

Note: The tasks for bothALM – Defect Template with Quality Center Integration and
ALM – Request for Change (RFC) Integrationmust be completed. The order this is done
in does not matter, but the tasks for both request types must be completed in an R2D
environment.

n ALM – Defect Template with Quality Center Integration.

i. The Configure QC/ALM Integration for Request Type: ALM –Defect Template with
Quality Center Integration section opens showingStep 1: Configure Server Details.
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In this example, the selected request type ALM –Default Template with Quality Center
Integration includes theQC/ALM Defect Information field group. It is associated with an
HP ALM defect, as indicated in theEntity Type field. For a new integration, the status is
Disabled by default.

Complete the fields using the following information and click Next.

Field
Name Description

*QC/ALM
Version

Select your HP ALM version from the drop-down list of supported
versions.

*QC/ALM
Server
URL

URL of the HP ALM server in the following format:

http://<ALM_Server_Host>:<Port>/qcbin/

Note: HTTPS is supported. Use https in the URL as needed.

*QC/ALM
Username

User name used to access HP ALM.

*QC/ALM
Password

Password for the QC/ALM user name.
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Field
Name Description

*QC/ALM
server
time zone

Time zone for the ALM server. Required to ensure that the integration
correctly manages updates between fields mapped as bidirectional
between PPMCenter requests and associated HP ALM defects. Default
is the time zone for the PPM Server.

Note: For some of the GMT time zones, only theDaylight Savings
Time Not Used option is available. Time zone names that include
city names are not available due to changes with a third-party
product. For example, youmay only see theGMT +9:00 Daylight
Savings Time Not Used option, whichmeans that theGMT +9:00
(Asia/Yakutsk) Yakutsk Time option is not available.

*QC/ALM
Domain

Domain on the HP ALM server to use for the integration.

Note: To retrieve the set of domains, click Get Domains.

*QC/ALM
Project

HP ALM project to use for the integration.

Note: List is populated whenQC/ALM Domain is selected.

*Entity
Type

HP ALM entity type to be used for integration—Defect.

Integration
Options

Additional options for ALM defect template with a QC integration.

Select one of the following three values:

l Creating a PPMCenter request automatically creates an associated
QC/ALM entity.

l Creating aQC/ALM entity automatically creates an associated PPM
Center request.

l Creating a PPMCenter request automatically creates an associated
QC/ALM entity, and vice versa.
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ii. The Configure QC/ALM Integration for Request Type: ALM –Defect Template with
Quality Center Integration section opens showingStep 2: Map PPM – ALM Fields.

Complete the fields using the following information and click Next.

Field Name Description

QC/ALM
Synchronization
Control Field

Specify a value in this field to allow theQC/ALM end users to
control whether they want to create a defect in PPM Center as a
result of creating a defect in ALM.

The values in the drop-down list are fields (with Y/N values)
retrieved from the Defect entity type of the ALM project specified
in theProject field.

Field Mapping Separate lists of unmappedQC/ALM Entity fields and PPM
Request fields, followed by a table of the preconfigured Current
Field Mappings
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iii. The Configure QC/ALM Integration for Request Type: ALM –Defect Template with
Quality Center Integration section opens showingStep 3: Complete Configuration.

Edit the notification options, if necessary. When finished, click Save & Enable.

Field Name Description

Notification
Options

Options for email notification when integration errors occur, and when
integration creates or updates entities
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n ALM – Request for Change (RFC) Integration.

i. The Configure QC/ALM Integration for Request Type: ALM –Request for Change (RFC)
Integration section opens showingStep 1: Configure Server Details.

In this example, the selected request type ALM –Request for Change (RFC) Integration
includes theQC/ALM Defect Information field group. It is associated with an HP ALM
defect, as indicated in theEntity Type field. For a new integration, the status is Disabled
by default.

Complete the fields using the following information and click Next.

Field
Name Description

*QC/ALM
Version

Select your HP ALM version from the drop-down list of supported
versions.

*QC/ALM
Server
URL

URL of the HP ALM server in the following format:

http://<ALM_Server_Host>:<Port>/qcbin/

Note: HTTPS is supported. Use https in the URL as needed.

*QC/ALM
Username

User name used to access HP ALM.

*QC/ALM
Password

Password for the QC/ALM user name.

Requirement to Deploy Concept and Configuration Guide
Chapter 4: Creating ALM Requirement/Defect from PPMRequest

HP Value Stream (2.1) Page 63 of 256



Field
Name Description

*QC/ALM
server
time zone

Time zone for the ALM server. Required to ensure that the integration
correctly manages updates between fields mapped as bidirectional
between PPMCenter requests and associated HP ALM requirements.
Default is the time zone for the PPM Server.

Note: For some of the GMT time zones, only theDaylight Savings
Time Not Used option is available. Time zone names that include
city names are not available due to changes with a third-party
product. For example, youmay only see theGMT +9:00 Daylight
Savings Time Not Used option, whichmeans that theGMT +9:00
(Asia/Yakutsk) Yakutsk Time option is not available.

*QC/ALM
Domain

Domain on the HP ALM server to use for the integration.

Note: To retrieve the set of domains, click Get Domains.

*QC/ALM
Project

HP ALM project to use for the integration.

Note: List is populated whenQC/ALM Domain is selected.

*Entity
Type

HP ALM entity type to be used for integration—Requirement.

Integration
Options

Additional options for ALM –Request for Change (RFC) Integration.

Location in ALM where requirements are created while integrating with a
PPM request.

Recommended value forDefault QC/ALM Folder Name is
Requirements.
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ii. The Configure QC/ALM Integration for Request Type: ALM –Request for Change (RFC)
Integration section opens showingStep 2: Map PPM – ALM Fields.

Complete the fields using the following information and click Next.

Field
Name Description

Field
Mapping

Separate lists of unmappedQC/ALM Entity fields and PPMRequest fields,
followed by a table of the preconfigured Current Field Mappings.

iii. The Configure QC/ALM Integration for Request Type: ALM –Request for Change (RFC)
Integration section opens showingStep 3: Complete Configuration.

Edit the notification options, if necessary.

Field Name Description

Notification
Options

Options for email notification when integration errors occur, and when
integration creates or updates entities

5. Click Save & Enable.
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Configuring Workflow for Request to Requirement Integration

To configure the workflow for the Request to Requirement integration:

1. From themenu bar, select Open > Administration > Open Workbench.

ThePPM Workbench opens.

2. From the navigation pane, select Configuration > Workflows.

TheWorkflow Workbench dialog box opens with theQuery tab selected.

3. Click List .

TheResults tab opens.
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4. Double-click ALM – Request For Change.

TheWorkflow: ALM –Request for Change dialog box opens with the Layout tab selected.

5. Right-click Step 23Non Release Sub WF.

6. Select Edit Source.
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TheWorkflow: Non Release SubWF dialog box opens with the Layout tab selected.

7. Right-click Step 4Quality Process Mode.

8. Select Edit.

TheWorkflow Step dialog box opens with theProperties tab selected forWorkflow Step 4.
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9. Update the Step 4Request Status:

a. Click theSelection icon.

The Validate dialog box opens.

b. Select Approved andOK.

10. In theWorkflow Step dialog box, click OK.

11. In theWorkflow: ALM –Request for Change dialog box, click Save and close the
Workflow Workbench.

Requirement to Deploy Concept and Configuration Guide
Chapter 4: Creating ALM Requirement/Defect from PPMRequest

HP Value Stream (2.1) Page 69 of 256



Verification

Note: This procedure is to verify that the implementation was done successfully.

To open an ALM defect from a PPM request:

1. In PPM, click Create > Requests > Other types ....

2. In the Request Type window, select ALM – Defect Template with Quality Center Integration.

3. Click Create.

4. Fill in themandatory requests fields.

5. Check that the information in the QC/ALM Defect Information pane is correct and that
Synchronize to QC/ALM Defect is checkedYes.

6. Click Submit.

7. In the Request Creation Confirmed window that opened, click theRequest ID.
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8. In the QC/ALM Defect Information pane, check that QC/ALM Defect Number contains a valid
defect number from ALM and that the QC/ALM Defect Status contains the valueNew.

9. Go to theALM client.

10. Open the Defect pane.

11. Search the Defect according to the Defect number in PPM.

Note: To verify opening an ALM requirement from a PPM request, follow the same procedure
using theALM – Request For Change request type.
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Chapter 5: Viewing ALM Quality Metrics in PPM
This chapter includes:

Overview 72

Configuring ALM – PPM View Project Quality Integration for PPM Project 73

Configuring ALM – PPM View Project Quality Integration for PPM Task 79

Verification 85

Overview
This chapter describes how to configure theView Project Quality integration. The View Project
Quality integration solution integrates HP Project and Portfolio Management (PPM) Center with the
Releases module of the HP Application Lifecycle Management (ALM) product. The integration allows
project management officers, project managers, development managers, andQA managers to have
visibility into quality KPIs and ALM scorecards from PPMCenter projects, and allows them to optimize
themanagement of project quality.

In the context of the Requirement to Deploy (R2D) Value Stream, this integration is usedmainly in
complex projects which includemultiple application releases.

For more information, see Integration ID#633: View Project Quality (PPM –ALM) inHP Software
Solutions Now.

The following diagram illustrates the relationship between the products for this integration:
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Configuring ALM – PPM View Project Quality Integration for
PPM Project
This section contains the following topics:

Overview 73

Configuring ALM – PPM View Project Quality Integration for PPM Project 73

Note: This integration is part of the Requirement to Deploy Value Stream. Step 3 is mandatory
whether you are configuring the ALM –PPM View Project Quality Integration for PPM Projects
and/or PPM Tasks.

Overview

The integration between a PPM project and ALM release provides quality-related information into the
PPM project that can be retrieved from ALM for project stakeholders and participants.

Configuring ALM – PPM View Project Quality Integration for PPM
Project

This section contains the following steps:

Step 1: Adding the QC/ALM Release Information Field Group to the Request Header Type
Associated with the Request Type 73

Step 2: Adding an ALM Integration Configuration 77

Step 3: Enabling and Scheduling the QC Integration Sync KPI Service 78

Note: This integration is part of the Requirement to Deploy Value Stream. Step 3 is mandatory
whether you are configuring the ALM –PPM View Project Quality Integration for PPM Projects
and/or PPM Tasks.

Step 1: Adding the QC/ALM Release Information Field Group to the Request
Header Type Associated with the Request Type

1. Log on to PPM Center with administrative privileges.

2. From themenu bar, select Open > Administration > Open Workbench.
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ThePPM Workbench opens.

3. From the navigation pane, select Demand Mgmt > Request Types.

TheRequest Type Workbench opens.

4. In theRequest Type field, enterProject Details.

Note: You can create new project types. Instead of using the system default request types
directly, create your own project types with customized project type associated request
types.

For details, see Chapter 10, "Integrating PPM Center Projects with HP ALM Releases – View
Project Quality" > "Configuring the Integration Solution" > "Configuring Project Types" >
"Creating New Project Types with Customized Project Type Associated Request Types" on
page 308 in theHP Project and Portfolio Management Center Solution Integrations Guide.
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5. In theResults tab, open theProject Details request type.

The Request Type: Project Details dialog box opens.
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6. In theRequest Header Type field, click Open.

The Request Header Type dialog box opens.

7. Click Field Groups.

The Field Groups dialog box opens.
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8. Select the check box for theQC/ALM Release Information field group, and click OK.

TheQC/ALM Release Information field group is added to the request header type.

9. Click OK.

Step 2: Adding an ALM Integration Configuration

Note: This integration is part of the Requirement to Deploy Value Stream. This step is mandatory
whether you are configuring the ALM –PPM View Project Quality Integration for either PPM
Projects and/or PPM Tasks. This task only has to be done once.

1. Log on to the PPMCenter with administrative privileges.

2. From themenu bar, select Open > Administration > Integrations.

The Integration Configuration landing page opens.
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3. In the navigation pane, click View Project Quality.

The View Project Quality integration configurations page opens.

4. In the Server Configuration Details section, click Add Integration Configuration.

The Server Configuration Details section appears.

5. Complete the fields described in the following table.

Field (*Required) Description

*QC/ALM Server Name Specify a unique name for the target ALM
server

Note: The server name shall not
contain pound sign (#) or space

*QC/ALM Version Select ALM server version from the drop-
down list of supported versions. Valid
values includeALM 11.00, ALM 11.20,
ALM 11.50, andALM 12.00.

*QC/ALM Server URL URL of the ALM server you want to
integrate with. For example,
http://ALM11.company.net:8080/qcbin/

*QC/ALM Username ALM account user name that you use to log
on to the ALM server

*QC/ALM Password Password of your ALM account

Description Provide a description for the ALM server

6. Click Save.

Step 3: Enabling and Scheduling the QC Integration Sync KPI Service

1. Log on to PPM Center with administrative privileges.

2. From the PPMCenter menu bar, select Open >Administration > Schedule Services.

TheSchedule Services page opens.

3. Click the table row that displays theQC Integration Sync KPI Service.

The editable fields for that service are enabled.
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4. To enable the service, from theStatus list, select Enabled.

5. Leave/change the type of expression in theSchedule Type list toSimple.

6. In theSchedule column, leave/change the default value (24 hours).

7. Click Save.

Note: Once you save the changes, they take effect immediately. There is no need to restart
the PPM Server.

Configuring ALM – PPM View Project Quality Integration for
PPM Task
This section contains the following topics:

Overview 79

Configuring ALM – PPM View Project Quality Integration for PPM Task 80

Overview

This integration extension enables project managers tomanagemultiple HP Application Lifecycle
Management (ALM) releases with one HP Project and Portfolio Management (PPM) Center project by
integrating project tasks with ALM releases.

The integration of PPM Center tasks with the Releases module of the ALM product allows project
management officers, project managers,development managers, andQA managers to have visibility
into quality KPIs and ALM scorecards of multiple ALM releases from PPMCenter projects. This is
accomplished by integrating the PPMCenter tasks with ALM releases and allowing them to optimize
themanagement of project quality.

The integration allows project managers to link a task under a project to a specific releasemanaged in
ALM. Each PPMCenter task is associated with a single release in ALM throughout the task life cycle.
This is a one-way one-to-onemapping relationship. This association begins when a project manager
maps one task to a specific ALM release.

After themapping relationship is established, the project managers are able to view quality KPIs and
ALM scorecard reports for a release retrieved from ALM. In addition, project managers can also view
the overall release hierarchy information of a specific work package from within PPM Center.

Requirement to Deploy Concept and Configuration Guide
Chapter 5: Viewing ALMQuality Metrics in PPM

HP Value Stream (2.1) Page 79 of 256



Configuring ALM – PPM View Project Quality Integration for PPM
Task

This topic contains the following steps:

Step 1: Downloading the HP PPM Plug-in for ALM Integration 80

Step 2: Installing the HP PPM Plug-in for ALM Integration 81

Step 3: Adding an ALM Integration Configuration 82

Step 4: Enabling and Scheduling the Project Quality Sync Service 84

Note: This integration is part of the Requirement to Deploy Value Stream. Step 3 is mandatory
whether you are configuring the ALM –PPM View Project Quality Integration for PPM Projects
and/or PPM Tasks.

Step 1: Downloading the HP PPM Plug-in for ALM Integration

To integrate PPM Center tasks with HP ALM releases, download and install the free HP ALM
Integration Plug-in for PPM. Obtain the plug-in bundles from the HP Live Network PPM Community.

1. On the PPMCommunity home page, click Content Catalog.
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2. Click HP ALM Integration Plug-in for PPM (where HP is the provider).

3. Click Downloads.

The HP ALM Integration Plug-in for PPM –Downloads page opens.

4. Select theALM Integration Plug-in for PPM 9.30 folder.

5. Click ppm-930-ALMPlugin.zip and download the package.

This package contains the following two bundles:

n ppm-930-PluginQuality.jar

n ppm-930-PluginQualityVPQ.jar

Step 2: Installing the HP PPM Plug-in for ALM Integration

1. Copy the ppm-930-ALMPlugin.zip package to the PPM Server.

2. Log on to the PPM Server via a remote desktop protocol (RDP).

3. Stop the PPM Server.

a. In the PPM Server, open a command line.

b. Go to the <PPM home>\bin folder.
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c. Run the following script: sh kStop.sh -now -user <admin_user>

Note: <admin_user> is a user with administrative privileges in PPM.

4. Unzip the ppm-930-ALMPlugin.zip package and copy the two bundles to the <PPM_Home>
directory.

5. Deploy the bundles.

a. Open a command line.

b. Go to the <PPM home>\bin folder.

c. Run the following script: sh ./kDeploy.sh -i PluginQuality

d. Run the following script: sh ./kDeploy.sh -i PluginQualityVPQ

6. After deploying the two bundles described in steps 5.c. and 5.d., run the following script:
sh ./kUpdateHtml.sh

7. Start the PPM server.

a. Open a command line.

b. Go to the <PPM home>\bin folder.

c. Run the following script: sh kStart.sh

Step 3: Adding an ALM Integration Configuration

Note: This integration is part of the Requirement to Deploy Value Stream. This step is mandatory
whether you are configuring the ALM –PPM View Project Quality Integration for either PPM
Projects and/or PPM Tasks. This task only has to be done once.

1. Log on to the PPMCenter with administrative privileges.

2. From themenu bar, select Open > Administration > Integrations.
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The Integration Configuration landing page opens.

3. In the navigation pane, click View Project Quality.

The View Project Quality integration configurations page opens.

4. In the Server Configuration Details section, click Add Integration Configuration.

The Server Configuration Details section appears.

5. Complete the fields described in the following table.

Field (*Required) Description

*QC/ALM Server Name Specify a unique name for the target ALM
server

Note: The server name shall not
contain pound sign (#) or space

*QC/ALM Version Select ALM server version from the drop-
down list of supported versions. Valid
values includeALM 11.00, ALM 11.20,
ALM 11.50, andALM 12.00.

*QC/ALM Server URL URL of the ALM server you want to
integrate with. For example,
http://ALM11.company.net:8080/qcbin/

*QC/ALM Username ALM account user name that you use to log
on to the ALM server

*QC/ALM Password Password of your ALM account

Description Provide a description for the ALM server

6. Click Save.
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Step 4: Enabling and Scheduling the Project Quality Sync Service

1. Log on to PPM Center with administrative privileges.

2. From the PPMCenter menu bar, select Open > Administration > Schedule Services.

The Schedule Services page opens.

3. Click the table row that displays theProject Quality Sync Service.

The editable fields for that service are enabled.

4. To enable the service, from the Status list, select Enabled.

5. Leave/change the type of expression in theSchedule Type list toSimple.

6. In theSchedule column, leave/change the default value of 24 hours.

7. Click Save.
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Verification

Note: This procedure is to verify that the implementation was done successfully.

To relate a PPM task to an ALM release:

1. In PPM, navigate toSearch > Projects and select your project.

2. In theProject Summary, click Edit Work Plan.

3. Double click the task you want to relate to an ALM release.

4. Go to theQuality tab.

5. Click Start Mapping.

6. Select the ALM server you’ve configured in previous steps, and click Next.

7. Enter the user name and password that you use to log on the target ALM server, and click Next.

8. Specify a quality development project that you want to link to:

a. Choose an ALM domain.

b. Choose an ALM project.

c. Choose an ALM release.

9. Click Confirm.

10. In the confirmation step, click Done.
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11. Check theQuality tab the following day to confirm that the data was updated from the ALM
release.

Note: Since we scheduled the Sync Service Schedule to run every 24 hours, we can only
verify the integration the following day. You can change that, thus allowing the integration
verification to run faster.
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Chapter 6: Viewing Source Code and Build Data in ALM
via ALI
This chapter includes:

Overview 87

Prerequisites 88

Retrieving and Displaying Build Information 88

Overview
This integration enables HP Application Lifecycle Management (ALM) to connect to a customer's
source codemanagement system (SCM) and build systems. This is facilitated by the HP Application
Lifecycle Intelligence (ALI) component. For the latest version of the ALI plug-in and accompanying
documentation, see HP Application Lifecycle Intelligence on HP Live Network.

In the context of the Requirement to Deploy (R2D) Value Stream, this integration enables the
traceability between a defined requirement (in ALM) to a set of source code changes (done in the
Source CodeManagement tool of the customer's choice) and the build which contains this set of
source code changes.

The following diagram illustrates the relationship between the products for this integration:
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Prerequisites
The following products must be installed:

l ALM is installed.

l At least one ALM project with:

n ALM Dev Extension

n Application Lifecycle Intelligence 2.6 (or higher)

n ALM Lab Extension for functional and performance testing

Note: HP ALI supports several common Source CodeManagement (SCM) and Build
Management solutions. For detailed instructions, refer to the ALI documentation on the
HP Software Product Manuals Web site. The instructions provided here are specific for using Git
as SCM and Jenkins as Build Management.

Retrieving and Displaying Build Information
This section contains the following topics:

Installing Hudson/Jenkins Plug-in 88

Configuring Hudson/Jenkins Plug-in 90

Integrating with the Git Source CodeManagement System 93

Installing Hudson/Jenkins Plug-in

According to the instructions in HP Live Network (HPLN), download the ALI bundle from HPLN at
https://hpln.hp.com/group/application-lifecycle-intelligence. The ALI bundle version depends upon your
ALM version.

From the ALI bundle at agents\buildintegration\hudson\, install the HP ALI Hudson/Jenkins
plug-in. This plug-in supports both the Hudson and Jenkins systems.

To install the HP ALI Hudson/Jenkins plug-in:

1. From the Hudson/Jenkins home page, open the Plug-in Manager and click theAdvanced tab.

2. In the Upload Plug-in section, browse to ali-hudson-plugin.hpi located in the ALI bundle, and
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click upload.

Note: If the project source code built by Jenkins is stored in Git, first download and install the
Jenkins Git plug-in from Jenkins and then install the alihudson-git-plugin.hpi and the
base ali-hudson-plugin.hpi.

3. After uploading the plug-ins, restart the Hudson/Jenkins server to enforce the changes.

4. Confirm that the installed plug-ins are listed in the Installed tab in the Plug-in Manager.

5. Confirm that theALI Integration link is visible in the Jenkins menu on the left side of the screen.
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6. Click theALI Integration link to display the capabilities provided by the Hudson/Jenkins
plug-in. The Jenkins andGit plug-in appear as follows:

Note: Formore information, see the latest HP Application Lifecycle Intelligence (ALI) User
Guide.

Configuring Hudson/Jenkins Plug-in

To configure the ALI-related settings in the Jenkins build server:

1. Navigate to Jenkins > Manage Jenkins > Configure System and scroll down to ALI-related
settings.

2. Provide default settings in order to be able to alter the configuration for individual build jobs. The
default settings should include the ALM URL, domain and project names, ALM user credentials,
and the name of the build server as defined in ALM configuration.
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To set up the name of the build server in ALM:

1. Log on to the ALM project with administrator credentials.

2. In theManagementmodule, select Build Servers and click theNew Server button.

3. Use your own build server details to fill in the details of the build server.

4. In the Jenkins configuration created in Step 2 in the previous section, test the connection to the
ALM project and, if the test passes, apply the changes.
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5. In the ALM build server configuration, edit theBuild Configurations tab to include the build jobs
and assign them to a specific release.

The result of this configuration is the capability of ALM to periodically (default 60minutes) retrieve build
information from build servers and display the build information in theBuildsmodule of the
Development tab.
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Integrating with the Git Source Code Management System

To integrate with the Git Source Code Management System:

1. In ALM, navigate toManagement > SCM Repositories and click theNew Repository button.

2. Select Git Provider as the type of Source CodeManagement (SCM).

3. Fill in the details of the SCM system, including the location (URL of Git server), and a shared
folder for local copy of the repository. The path should be located in the ALM repository folder.

4. Modify theChange Detection andCommit Pattern settings, if necessary.
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Note: There are two check boxes—Scheduled Polling and Receive from Agents.

n ForChange Detection, it is recommended to at least enable the Scheduled Polling.

n ForCommit Pattern, the default is Basic and allows utilization of most features, such as
linking code changes to requirements and defects.

5. Edit the newly added SCM repository as follows:

a. Select theBranches tab.

b. Click theNew SCM Branch button and edit the details.

Note: For Git SCM, the branch path will usually be “/” and the branch namewill be
something simple like "master" (and not "refs/head/master").
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6. To validate successful configuration, commit some code changes to the SCM system.

a. After scheduled synchronization (default every 60minutes) is executed, the list of changes
can be seen in the ALM Development module underCode Changes.

b. If the commit messagematches the rules defined inCommit Pattern (for example, fixing
defect #14), the code change will be linked to the defect with ID#14 in ALM, shown in the
following screen shot.
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Chapter 7: Building and Deploying an Application
This chapter includes:

Overview 96

Prerequisites 96

Software Build and Deployment 97

Test Execution 100

Overview
To build an application and then deploy it in a development environment, start with a Jenkins build job,
which pulls source code from theGit repository, and then builds it and archives the build artifacts.
Those artifacts are then automatically deployed on freshly provisioned servers based on the
deployment template stored in Codar. Another Jenkins job uses the details of the deployment to
configure an AUT environment in ALM LabManagement and trigger a Build Verification Suite
execution.

Thus the process of Check-in > Build > Deploy > Test is executed automatically.

Prerequisites
l Build server (in our example, Jenkins) configured to build the software that is being developed

l Codar installed and ready to deploy the application design

l ALM installed and configured to execute automated tests (for example, via an integration with
United Functional Testing)
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Software Build and Deployment

To create a software build and deployment job:

1. Begin with a new Jenkins free-style build job that queries the source code repository (in this
example, Git) for changes and, If changes are found, triggers the build process and archives the
build artifacts.

For example,
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2. Add actual build step/steps as shown in the following example that uses an Apache Ant target.
You can also useMaven, Gradle, or any other build automation tool that is supported by the build
server—for instance, Jenkins.

3. Add a post-build step that will trigger automatic deployment of the build artifacts on a newly-
provisioned environment.

To add the post-build action:

a. Click theAdd post-build action drop-down arrow and select HP Helion Codar Plugin from
the list.

b. Complete the form with details for the HP Codar instance used, plus the location of the
application design exported from Codar.

Note: This must be done in .json format.

For instructions on how to export the application design, see HP Helion Codar API Quick Start
Guide.

For instructions on installing the HP Helion Codar Jenkins Plug-in, see “Install the Helion
Codar Jenkins Plug-in” in the HP Helion Codar Installation and Configuration Guide
(https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM01288418).
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For instance:

c. Click theAdd Nodes button and fill in the NodeId field with the ID of the VCenter component
from the application design JSON. In our example, it is VcenterServerType__VERSION__
04.20.0000__GROUPID__com.hp.csa.type0002. This enables the plug-in to store the
details of the specific node that was deployed by Codar for test execution as described in
"Test Execution" on the next page.

d. Click theSave button.

Validation

When these steps are completed successfully, triggering a new build results in the built software
package being deployed according to the application deployment template in Codar for the appropriate
development environment.
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Test Execution

To create a build job that will execute automated tests on software built and
deployed in previous steps:

1. Install the Copy Artifact Plugin (https://wiki.jenkins-
ci.org/display/JENKINS/Copy+Artifact+Plugin) for Jenkins.

2. Create a new Jenkins freestyle job. It should be parameterized with the following parameters:

Type Name Default Value

String AUT_Environment_Configuration_ID

String Codar_Output CodarOutput.json

String Port 8080

3. Add the build stepCopy artifacts from another project and select the project which builds and
deploys the developed product.
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4. Add another build step: Execute AUT Environment preparation using HP ALM Lab
Management.

Fill in the following fields according to the environment specifics:

Field Value (example) Comment

AUT Environment ID 1001 AUT environment ID should
exist in ALM LabManagement

AUT Environment
Configuration

Check box: Create new
configuration named—From_
Jenkins

Used to discern the AUT
configurations created
automatically

Path to JSON file ${WORKSPACE}\${Codar_
Output}

Assign EUT
Environment
Configuration ID to:

AUT_Environment_
Configuration_ID
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5. Click theAdd Parameter button.

Add the following additional parameters:

Parameter
Type Parameter Name Parameter Value

Environment Parameters/App server/port Port

From JSON Parameters/App
server/ipAddress

$.Nodes[0].properties[(@.length-
1)].values[0]

6. Click theSave button to save the changes.

7. Click theAdd build step drop-down arrow and select Execute HP tests using HP ALM Lab
Management from the list.

Provide the details of the appropriate ALM environment, as well as the Test Set/Build Verification
Suite ID.
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For example:

8. Click theAdd Post-build Actions drop-down arrow and select Publish HP tests tesult from the
list.

9. Click Save button.

Validation

When these steps are configured correctly, running a new build with the same parameters creates a
new Environment Configuration in ALM and triggers the appropriate test set execution.

The overall result is a build triggered upon code change that gets built, is deployed by Codar, and is
automatically tested by HP Automation tools.
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Chapter 8: Syncing Defects, Releases and
Requirements Between ALM and Agile Manager
This chapter includes:

Overview 104

Integrating ALM with Agile Manager 105

Verification 131

Overview
HP Application Lifecycle Management (ALM) Synchronizer enables you to link ALM projects and
HP Agile Manager (AgM) workspaces, and synchronize their releases, requirements/user stories, and
defects.

Note: For the integration between ALM and Agile Manager, a specialized version of ALM
Synchronizer is used.

In the context of the Requirement to Deploy (R2D) Value Stream, this integration enables the following:

l Provides the testing aspect for user stories managed in Agile Manager.

l Ability to publish an Agile Manager defect to ServiceManager users as aKnown Error, using the
current ALM – SM integration to create an SM Problem based on an ALM Defect. For more details,
see "Creating an SM Problem from ALM Defect" on page 133.

l Views project quality in PPM for Agile releases managed in Agile Manager. ALM is the central
system for managing quality for both ALM and Agile Manager releases.

For more information, see Integration ID#751: Agile Manager Integration with HP ALM (AgM –ALM) in
HP Software Solutions Now.
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The following diagram illustrates the relationship between the products for this integration:

Integrating ALM with Agile Manager
Synchronizer checks ALM and Agile Manager for recent updates in the synchronized items, and
updates the other endpoints accordingly. You can configure the direction in which changes are
synchronized between the endpoints—from ALM to Agile Manager, from Agile Manager to ALM—or in
some cases, both ways.

This section contains the following steps:

Step 1: Installing the Synchronizer Server and Client 106

Step 2: Adapting Your Agile Manager Project 106

Step 3: Adapting Your ALM Project 107

Step 4: Creating a Synchronization Link 110

Step 5: Configuring Link Properties 114
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Step 1: Installing the Synchronizer Server and Client

Synchronizer contains the following components, which can reside on either the same or separate
machines:

l Synchronizer Client. Displays current links and provides a user interface for creating and
managing links, and running link tasks. Sends user requests to the Synchronizer server using
SOAP/HTTP.

l Synchronizer Server. Synchronizes data between ALM and Agile Manager. Manages
synchronization and communication between endpoints, and retrieves and stores information in an
integrated database.

Note: For the complete installation procedure, seeHP ALM Synchronizer for Agile Manager or go
to yourAgile Manager Help Center and select HP ALM Synchronizer for Agile Manager >
Install a Synchronizer System.

Step 2: Adapting Your Agile Manager Project

1. Log on to Agile Manager.

2. Go toConfiguration.

3. Click Customization.

4. In Custom Fields, click Add Field and add the following fields:

Apply To Field Label Field Type

Detect ALM_Defect_ID Numeric

User Story ALM_End_Date Date

5. After adding each field, click eitherSave and Add Another orSave as required.

Note: If the additional fields are required from ALM entities to be synchronized with Agile
Manager, add them during this stage—or use these instructions to add them later.
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Step 3: Adapting Your ALM Project

1. Create new requirement types in ALM.

a. Log on to the ALM project as an administrator.

b. Click Tools > Customize.

c. Click Requirement Types.

d. Click New Type and add three types of requirements that represent HP Agile Manager
themes, features, and user stories.
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The new Requirement Types should look as follows:

2. Create user defined fields for additional Agile Manager fields.

a. Log on to ALM project as an administrator.

b. Click Tools > Customize.

c. Click Project Entities and create the following fields:

i. Defect.

A. In the Project Entities window, click Defect.

B. Click User Fields.

C. Click New Field.
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D. In the Settings window, enter the following information:

E. In the Project Entities window, click Save.

ii. Release.

A. In Project Entities window, click Release.

B. Click User Fields.

C. Click New Field.

D. In the Settings window, enter the following information:

Label AGM_End_Date

Type Date

E. In the Project Entities window, click Save.

iii. Requirement.

A. In Project Entities window, click Requirement.

B. Click User Fields.

C. Click New Field.

D. In the Settings window, enter the following information:

Label AGM_Author

Type User List
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E. Click New Field.

F. In the Settings window, enter the following information:

Label AGM_Req_ID

Type Number

G. Click New Field.

H. In the Settings window, enter the following information:

Label FeatureStoryPoints

Type Number

I. In the Project Entities window, click Save.

d. In the Project Entities window, click Save.

Step 4: Creating a Synchronization Link

Synchronization is defined by links, which you create andmanage in the HP ALM Synchronizer Client.

Links are created between a pair of endpoints—namely an instance of ALM and an instance of Agile
Manager. Links run tasks to synchronize records between the endpoints.

Each link defines the types of records that are synchronized, how often, and under what
circumstances. The entity type being synchronized in a specific link determines the fields that you can
map from each endpoint.

Note: A link must be created for each of the three entity types—releases, requirements/user
stories, or defects.

1. OpenHP ALM Synchronizer Client.

2. Log on to HP ALM Synchronizer Client as an administrator.

3. In themain toolbar, click Link > Create.
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4. In the new Create Link dialog box, perform the following Steps 1-4 for all three project entities—
defects, requirements and releases:

a. In the Step 1 of 4 –General Properties dialog box, Assign general properties, enter the Link
name and click Next.
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b. In the Step 2 of 4 – HP ALM Endpoint dialog box, assign HP ALM endpoint connection
properties.

i. Specify authentication details for the ALM user name you want to use to connect to the
ALM endpoint.

Note: The ALM user defined for the synchronization link must have create, modify,
and delete permissions for the entity being synchronized (defect or requirement) in
the ALM project.

ii. Populate theServerURL using the following syntax:

http://<ALM server name>[<:port number>]/qcbin

iii. Fill in theDomain andProject fields for the ALM project you want to connect to.

Note: You can also select a project from a list of available projects.

To do so, click Set Connection. In the HP ALM Connection dialog box, enter the
connection settings for the ALM server you want to connect to, and then enter the
user and project details.

iv. To verify the connection to the ALM project, click Check Connectivity. Youmay want
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to test connectivity to several projects before finalizing a project for the link.

v. Click Next.

c. In the Step 3 of 4 – Assign HP Agile Manager Endpoint dialog box, assign endpoint connection
properties.

i. Specify authentication details for the Agile Manager user name you want to use to
connect to the Agile Manager endpoint.

ii. Define the following settings for the Agile Manager site and workspace you want to
connect to:

ProductGroupId The workspace ID, as displayed in theWorkspaces
configuration page (Site > Workspaces)

TenantID You can find the tenant (site) ID in the Agile Manager URL.

For example, TENANTID=123456789.

ServerURL Use the following syntax:

http(s)://<server name>:<port number>/agm
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Domain You can find the server URL in the Agile Manager URL.

For example,

https://myserver.mycorp.com/agm/webui/alm/<Domain>...

Project Always defined as Main

iii. Click Check Connectivity to verify the connection to the Agile Manager workspace.

iv. Click Next.

d. In the Step 4 of 4 – Entity Types dialog box, select the entity you wish to sync.

5. Repeat steps a-d for the two remaining entity types.

Be sure you have three links—one for each of the three entity types (releases, requirements/user
stories, and defects).

Step 5: Configuring Link Properties

Link properties include all information about the link. Somemain properties are displayed for all links in
a sortable grid, and additional properties are displayed for a specific link in a series of tabs.

Although we recommend setting the synchronization job as described below (which will suit most
customers), this can bemodified for specific needs. For more details, inAgile Manager Help, see
HP ALM Synchronizer for Agile Manager > Set up Synchronizer > Configure server options.
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Note: Formore information, see HP ALM Synchronizer for Agile Manager > Configure Links.

1. Defect.

a. Click theDefect link.

b. Click Edit button.

c. Go to theScheduling tab.

i. Select enable scheduling.

ii. Select Run incremental synchronization task.

iii. Select Schedule every X and set it up as you wish.
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d. Go to the Field Mapping tab andmap the fields as follows:

i. To set up ValueMapping, go to the lower right-hand tab and click Value Mapping.

ii. To set the direction of the link, click Map Selected Fields and select a direction. The
default is bi-directional mapping.
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The following table provides the recommendedmapping values for the R2D deployment:

HP-ALM
Defect
Schema

HP-Agile-
Manager
Defect
Schema Direction Value Mapping

Summary Summary Bi-
directional

No

Status Defect
Status

Bi-
directional

Yes. Map the status to the appropriate
value between Agile Manager and ALM.

Detect on
Date

Detect on
Date

Bi-
directional

No

Severity Severity Bi-
directional

Yes. Map the severity to the appropriate
value between Agile Manager and ALM.

For example, 5-Urgent <-> 1-
Critical.

Assigned To Assigned To Agile
Manager
to ALM

Yes. Map the users that are assigned to
the defect between Agile Manager and
ALM.

Description Description Bi-
directional

No

Closing
Date

Closing on
Date

Bi-
directional

No

Detected By Detected By Bi-
directional

Yes, map the users to whom themapwas
detected by between Agile Manager and
ALM. This should be bi-directional.

Comments Comments Bi-
directional

No

Link Link Bi-
directional

No

Detected in
Cycle

Sprint Agile
Manager
to ALM

No

Detected in
Release

Detected in
Release

Bi-
directional

Yes, map the ALM versions to the
appropriate Agile Manager releases.
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HP-ALM
Defect
Schema

HP-Agile-
Manager
Defect
Schema Direction Value Mapping

Priority Priority Bi-
directional

Yes, map the values for priorities between
Agile Manager and ALM.

For example, 2-Medium <-> 3-Medium

Target
Release

Release Agile
Manager
to ALM

Yes, map the Agile Manager versions to
the appropriate ALM releases.

Attachments Attachments Bi-
directional

No

Actual Fix
Time

Invested
(Hours)

Agile
Manager
to ALM

No

Estimated
Fix Time

Actual
(Hours)

Agile
Manager
to ALM

No

AGM_
Defect_ID

Defect ID Agile
Manager
to ALM

No

Defect ID ALM_
Defect_ID

ALM to
Agile
Manager

No
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iii. Go to theRules tab. Make your selections as shown in the following screen shot or you
can choose to set it up differently according to your organization's needs.

iv. Click Save.

v. Click Yes in the pop-up window.
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vi. Click Yes in the pop-up window.

vii. Check that the integrity check is complete.

viii. Click Enable Link.

2. Release.

a. Click theRelease link.
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b. Click theEdit button.

c. Go to theScheduling tab.

i. Select enable scheduling.

ii. Select Run incremental synchronization task.

iii. Select Schedule every X and set it up as you wish.

d. Go to the Field Mapping tab andmap the fields as follows:

i. To set up ValueMapping, go to the lower right-hand tab and click Value Mapping.

ii. To set the direction of the link, click Map Selected Fields and select a direction. The
default is bi-directional mapping.

The following table provides the recommendedmapping values for the R2D deployment:

HP-ALM Defect
Schema

HP-Agile-Manager Defect
Schema Direction

Value
Mapping

Name Name Bi-directional No

Start Date Start Date Bi-directional No

Description Description Bi-directional No

Attachments Attachments Bi-directional No

Cycles Sprints Bi-directional No

End Date End Date Bi-directional No

Requirement to Deploy Concept and Configuration Guide
Chapter 8: Syncing Defects, Releases and Requirements Between ALM and Agile Manager

HP Value Stream (2.1) Page 121 of 256



iii. Go to theRules tab. Make your selections as shown in the following screen shot or you
can choose to set it up differently according to your organization's needs.

iv. Click Save.

v. Click Yes in the pop-up window.
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vi. Click Yes in the pop-up window.

vii. Check that the integrity check is complete.

viii. Click Enable Link.
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3. Requirements.

a. Click theRequirement link.

b. Click theEdit button.

c. Go to theScheduling tab.

i. Select enable scheduling.

ii. Select Run incremental synchronization task.

iii. Select Schedule every Xand set it up as you wish.

d. Edit Subtype Mapping.

i. Go to theSubtype Mapping tab.

ii. In the HP ALM sub-window, select the Theme, Feature, andUserStory requirements
that you created in ALM in Step 3: Adapt your ALM project > Step 1.d, and click Add
Mapping.
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iii. Click Save.

Note: Confirm the three requirement types are created under the link.

iv. Select the Theme requirement type.

A. Go to theRules tab and define which endpoint you want to define as theMaster
endpoint. UnderHP Agile-Manager, selectMaster.

v. Select the Feature requirement type.

A. Go to theRules tab and define which endpoint you want to define as theMaster
endpoint. UnderHP Agile-Manager, selectMaster.

vi. Select theUserStory requirement type.

A. Go to theRules tab and define which endpoint you want to define as theMaster
endpoint. UnderHP Agile-Manager, selectMaster.

vii. Go to the Field Mapping tab for the Theme requirement type.

A. To set up ValueMapping, go to the lower right-hand tab and click Value Mapping.

B. To set the direction of the link, click Map Selected Fields and select a direction.
The default is bi-directional mapping.
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The following table provides the recommendedmapping values for the R2D
deployment:

HP ALM
Defect
Schema

HP Agile
Manager
Defect
Schema Direction Value Mapping

Name Name Bi-
directional

No

Comments Comments Bi-
directional

No

Creation
Date

Creation
Date

Agile
Manager
to ALM

No

Creation
Time

Creation
Time

Agile
Manager
to ALM

No

Description Description Bi-
directional

No

Attachments Attachments Bi-
directional

No

Link Link Bi-
directional

No

Author Author Bi-
directional

Yes. Map between Agile Manager
and ALM authors. If not, the
synchronizer will not be able to sync
requirements for authors that do not
exist in each application.
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viii. Go to the Field Mapping tab for the Feature requirement type.

A. To set up ValueMapping, go to the lower right-hand tab and click Value Mapping.

B. To set the direction of the link, click Map Selected Fields and select a direction.
The default is bi-directional mapping.

The following table provides the recommendedmapping values for the R2D
deployment:

HP-ALM
Defect
Schema

HP-Agile-
Manager
Defect
Schema Direction Value Mapping

Name Name Bi-
directional

No

Comments Comments Bi-
directional

No

Creation
Date

Creation
Date

Agile
Manager
to ALM

No

Creation
Time

Creation
Time

Agile
Manager
to ALM

No

Description Description Bi-
directional

No

Attachments Attachments Bi-
directional

No

Link Link Bi-
directional

No
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HP-ALM
Defect
Schema

HP-Agile-
Manager
Defect
Schema Direction Value Mapping

Author Author Bi-
directional

Yes. Map between Agile Manager
and ALM authors. If not, the
synchronizer will not be able to sync
requirements for authors that do not
exist in each application.

ix. Go to the Field Mapping tab for theUserStory requirement type.

A. To set up ValueMapping, go to the lower right-hand tab and click Value Mapping.

B. To set the direction of the link, click Map Selected Fields and select a direction.
The default is bi-directional mapping.

The following table provides the recommendedmapping values for the R2D
deployment:

HP ALM
Defect
Schema

HP Agile
Manager
Defect
Schema Direction Value Mapping

Name Name Bi-
directional

No

Comments Comments Bi-
directional

No

Creation
Date

Creation
Date

Agile
Manager
to ALM

No
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HP ALM
Defect
Schema

HP Agile
Manager
Defect
Schema Direction Value Mapping

Creation
Time

Creation
Time

Agile
Manager
to ALM

No

Description Description Bi-
directional

No

Attachments Attachments Bi-
directional

No

Link Link Bi-
directional

No

Author Author Bi-
directional

Yes. Map between Agile Manager
and ALM authors. If not, the
synchronizer will not be able to sync
requirements for authors that do not
exist in each application.

Direct Cover
Status

Status Bi-
directional

Yes. Map the values for the status
between Agile Manager and ALM.

The UserStory displays as shown in the following figure:

x. Click Save.
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xi. Click Yes in the pop-up window.

xii. Click Yes in the pop-up window.

xiii. Check that the integrity check is complete.

xiv. Click Enable Link.
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Verification

Note: These procedures are to verify that the implementations were done successfully.

To verify that defect data is being synced from Agile Manager to ALM:

1. Go to the ALM client.

2. In the left pane of the ALM client, openDefects.

3. Search for defects that were synced from Agile Manager. For example, compare the defect name
to the one being synced from Agile Manager or search for Agile Manager-related fields as seen in
the following screen shot (such as theProject field).

To verify that release data is being synced from Agile Manager to ALM:

1. Go to the ALM client.

2. In the left pane of the ALM client, openManagement.

3. Select Releases.
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4. Search for releases that were synced from Agile Manager.

To verify that requirement data is being synced from Agile Manager to ALM:

1. Go to the ALM client.

2. In the left pane of the ALM client, openRequirements.

3. Select Requirements.

4. Search for requirements that were synced from Agile Manager. There should be requirements for
Theme, Feature andUser Story types.
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Chapter 9: Creating an SM Problem from ALM Defect
This chapter includes:

Overview 133

Prerequisites 134

Configuring ServiceManager 134

Configuring Application Lifecycle Management 150

ALM Synchronizer 157

Verification 169

Overview
This integration supports the synchronization of various entities between HP ServiceManager (SM)
and HP Application Lifecycle Management (ALM). This chapter describes setting up a specific subset
of the integration capabilities—namely the capability to open a ServiceManager problem based on
information in ALM defect fields. Once the record is created in ServiceManager, it can bemarked as a
known error.

The outline for configuration includes modifying settings in ServiceManager, modifying settings in
ALM, installing a synchronizer component, and configuring link(s) which are responsible to synchronize
relevant entities between ServiceManager and ALM.

Note: The following configuration steps are an example and are provided here for your reference. If
the product is installed on a different operating system, database type, or was customized for
specific customer requirements, the screens andmenus may be different.

In the context of the Requirement to Deploy (R2D) Value Stream, this integration enables traceability
between defects managed in ALM as part of R2D and problems managed in SM as part of the Detect to
Correct Value Stream..

For more details, see the integration documentation—such as HP Defects and Requirements
Exchange with HP ServiceManager/ServiceCenter and HP Quality Center/Application Lifecycle
Management Installation and Administration Guide.
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The following diagram illustrates the relationship between the products for this integration:

Prerequisites
The following products must be installed:

l ServiceManager is available viaWindows and aWeb client.

l ALM is up and running and a project has been created.

Configuring Service Manager
The following procedure is an example of how to configure the default ServiceManager installation with
the Process Designer (PD) Content Pack installed. This affects multiple applicationmenus and
options. Configuration instructions for the default ServiceManager system can be found inHP Defects
and Requirements Exchange with HP ServiceManager/ServiceCenter and HP Quality
Center/Application Lifecycle Management.

This section contains the following steps:

Step 1: Creating an Integration Account That Will be Used by ALM Synchronizer to Connect to
ServiceManager 135

Step 2: Creating a "Security Role" Record for the Integration Account 135

Step 3: Modifying ProblemManagement to Allow for the Storage of Information About ALM
Defects 136
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Step 1: Creating an Integration Account That Will be Used by ALM
Synchronizer to Connect to Service Manager

1. In mainmenu, select System Administration > Base System Configuration > Contacts.

2. Complete the form and click theAdd button.

Step 2: Creating a "Security Role" Record for the Integration Account

1. Navigate toSystem Administration > Security > Roles and fill out the form as shown in the
following figure.

Click Save.

2. Update the created role with the parameters shown in the following table:

No Tab Page Field Value Comment

1 Security Role Name SMQCIntSecRole

2 Security Area Change

3 Rights View Yes Check box

4 Update Always

5 Security Area Problem

6 Rights View Yes Check box

7 New Yes Check box

8 Update Always
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3. Remove all rights from all areas with the exception of theChange area and theProblem area.

Step 3: Modifying ProblemManagement to Allow for the Storage of
Information About ALM Defects

1. Navigate to Tailoring > Database Dictionary and execute a search for rootcause.

2. Click theNew Field/Key button and add the following fields to the root cause
table:

Field Name Data Type

qcintegration.type StringType

qcintegration.id Number

qcintegration.project StringType

qcintegration.created.from StringType

Note: If there is a requirement to store additional information from ALM in the Service
Manager database, include those custom fields using the appropriate data type. Refer to
SM Online Help for additional information about ServiceManager customization.
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3. Create a custom External Access Definition, a web service endpoint that will allow ALM
Synchronizer to access specific ServiceManager records.

a. Navigate to Tailoring > Web Services > Web Service Configuration.

b. Populate the form with new service details:

Note: The captions and values aremandatory and hard-coded. Otherwise the
Synchronizer is not able to access ServiceManager data.

c. Click theAdd button andmodify the values of theWeb service definition.
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The Fields tab lists exposed fields which can bemapped in the ALM Synchronizer link
configuration. Be sure to include all of the fields that are necessary to create/update a Problem
record. The example below shows theminimum for an out-of-the-box ServiceManager
installation with Process Designer Content Pack.

Note: For fields starting with the qcintegration prefix, it is important to configure the field
captions exactly as shown. Otherwise the Synchronizer will fail to process the records.
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d. In theExpressions tab of theWeb service configuration, add the following lines:

Note: This is necessary because the ServiceManager workflow requires an update to be
completed whenever a Problem record is updated.

cleanup($pm.activity);cleanup($rc.update);if same(update in $L.file, update
in $L.file.save) then ($L.need.to.update=true)

$rc.update=update in $L.file;if (denull($rc.update)={}) then ($rc.update=
{"ALM update sent"})

if ($L.need.to.update=true) then ($rc.update={"ALM update sent"})

update in $L.file=update in $L.file.save

4. Create a global list that contains a list of ALM projects that will be used to open and update the
defects on the ALM side.

a. In the ServiceManager console, navigate to Tailoring > Tailoring Tools > Global Lists
and create a global list with the following parameters:

Parameter Value Remarks

List Name SMQC Integration PM Project
List

List

Regen Entry 1 00:00:00 Check box

Build List on
Startup?

Yes

List Variable $G.qcintegration.problem.project Check box

User Defined
List?

Yes

Value List <ALM server
host>/Domain/Project

List of ALM Projects targeted for
integration
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b. Click theAdd List button. Click theMoremenu and click Rebuild Global List.

5. Create a subform that displays ALM defect-related information in Problem forms. For this task, it
is necessary to use a ServiceManagerWindows client.

In themainmenu, select Tailoring > Forms Designer and create a new form called
pbm.almint.subform. As aminimum, it should contain the following components:

Component Properties

Label Caption: ALM Defect ID

Text Input: qcintegration.id

Read-Only: Yes

Label Caption: Server/Domain/Project

Combo Box Input: qcintegration.project

Mandatory condition: [qcintegration.type]>0

Label Caption: Created From

Text Input: qcintegration.created.from

Read-Only: Yes

Label Caption: Synchronize with ALM

Combo Box Input: qcintegration.type
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6. Add the subform created in the previous step to selected ProblemManagement forms:

a. In Forms Designer, locate one of the ProblemManagement forms and click Design.

Note: This could be named differently depending on which version of ServiceManager is
being used—for example, pbm.problem.logging.

b. Add aNotebook tab with the captionALM Integration and add the pm.almint.subform to it.
Save the changes.

c. Where needed, repeat the steps above for additional ProblemManagement forms to display
ALM-related information.

7. Create rules that will define the behavior of the fields we added in different phases of the Problem
record life cycle.

Note: Since we are using ServiceManager with the Process Designer Content Pack, the
following steps are different from the out-of-the-box ServiceManager setup.
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a. Navigate to Tailoring > Process Designer > Copy Existing Workflow.

b. Locate, select, and copy theProblem entry. Create a name for the new workflow—for
example, QCIntProblem.

c. From the System Navigator, navigate toProblem Management > Configuration >
Problem Categories and click Search.

d. In theProblem Category page, remove the currently assigned workflow from theWorkflow
field.

e. Select the problem category for which you want to add a workflow—for example, Problem.
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f. EnterQCIntProblem in theWorkflow field.

Note: Use the new workflow name defined in step b above.

g. Click Save to associate the Problem Category with the workflow.

h. Click Add Rule.
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i. Create a new rule set for initialization.

i. From the System Navigator, navigate to Tailoring > Process Designer > Rule Sets
and enter the values as shown in the following figure:

ii. Click New andSave.

iii. Click theAdd Rule button.

iv. In theSelect Rule Type page, click Run JavaScript.

v. On theRun JavaScript page, enter the following values and click OK.

Field Name Description

Rule
Description

Run JavaScript for initializing Integration type and project in the
Problem Record
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Field Name Description

Statement vars['$qcint.type.readonly'] = 2;

vars['$qcint.project.readonly'] = 2;

var_null=system.functions._null;

varfile = vars.$L_file;

if(file["qcintegration.type"] !=0 && !_null(file
["qcintegration.type"])) {

vars['$qcint.type.readonly'] = 1

}

if(file["qcintegration.type"] !=0 && !_null(file
["qcintegration.project"])) {

vars['$qcint.project.readonly'] = 1

}

vi. Click Save andExit.
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8. Create a new rule set for validation.

a. From the System Navigator, navigate to Tailoring > Process Designer > Rule Sets and
enter the following values:

Field Value

ID pbm.alm.int.validation

Name Validation for ALM integration in the Problem Record

Table Name rootcause

b. Click New andSave.

c. Click Add Rule.

d. In theSelect Rule Type page, click Set Mandatory Fields.

e. Click Edit.

TheCondition editor opens.

f. Add an expression as shown in the following figure and click Apply.

g. Add another expression as shown in the following figure and click Apply.
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h. After clickingApply, the following dialog box appears:

Click OK at the bottom of the dialog box.

i. Click OK. TheSet Mandatory Fields page closes.

j. Click Save andExit.

9. Associate the new workflow with the new initialization and validation rule sets.

a. From the System Navigator, navigate toProblem Management > Configuration >
Workflows.

b. Select QCIntProblem in the workflows list and click Open.

c. Select the first phase in the workflow graph.

d. Click theRule Sets tab and then the Initialization tab.
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e. Click Add and select the initialization rule set you just created.

10. Repeat steps 4 and 5 for theOn display andOn enter tabs.
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11. Select theOn enter tab and select the Validation rule set you just created.

12. Click Save.

This concludes configuration on the ServiceManager side. The result of the abovemodification allows
storage of ALM Defect-specific data in ServiceManager Problem tables.
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Configuring Application Lifecycle Management
The following procedure describes how to configure Application Lifecycle Management (ALM) and
includes:

l Adding custom fields to ALM entities (Defects) to store data from ServiceManager Problem

l Creating workflow rules that will lock specific fields once the user chooses to create a Problem
record based on Defect information

l Creating a filter for defects designated to be synchronized with ServiceManager Problems

This section contains the following steps:

Step 1: Creating an Integration Account 151

Step 2: Adding the Newly Created User Account to ALM Projects 151

Step 3: Modifying ALM Defects Module Fields 153

Step 4: Creating a Filter in ALM 155
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Step 1: Creating an Integration Account

To create an integration account that will be used by ALM Synchronizer to connect
to ALM:

1. In ALM Site Administration, navigate to theSite Users tab and click theAdd User button.

2. Fill in the details as shown in the following figure:

Step 2: Adding the Newly Created User Account to ALM Projects

To add the newly created user account to ALM projects where the synchronization
is needed:

1. Log on to the ALM Project as a user with Project Administration permissions and open theProject
Customizationmodule.

2. From the toolbar, select Tools, and thenCustomize.
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3. From the left-hand navigation pane, select Groups and Permissions.

4. In the Groups and Permissions pane, click theNew Group button and create new user group
namedSM Integration.

TheSet As field sets the permissions as defined in selected existing groups. From theSet As
drop-down list, select Viewer.

5. From the right side of the Groups and Permissions pane, select thePermissions tab.

a. In theDefects tab, modify the group permissions to allow the users of the group to add and
modify defects.
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b. In theAdministration tab, allow the user to add andmodify public and private favorite views.

6. Select theMembership tab and addSMALMIntUser to this new group.

Step 3: Modifying ALM Defects Module Fields

To modify ALM Defects Module fields for storing SM Problem data:

1. Log on to the ALM Project as a user with Project Administration permissions and open theProject
Customizationmodule.

2. From the toolbar, select Tools, and thenCustomize.

3. From the left-hand navigation pane, select Project Entitles.
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4. Add the followingUser fields toDefect in Project Entities:

Field Name (auto
assigned) Field Label Field Type

BG_USER_XX Synchronize
with SM
Problem

Lookup List: Yes/No
(select theVerify Value
check box)

BG_USER_XY Problem ID String

5. Click Save to apply changes.

6. ClickWorkflow > ScriptEditor.

7. Select theDefectsmodule script.
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8. Add the following lines to theBug_New andBug_Moveto subroutines (substitute XX and XY with
actual field numbers).

Note:We set the fields to be read-only once the user selects Yes in theSynchronize with
SM Problem field.

if (Bug_Fields("BG_USER_XX").Value="Y") then

Bug_Fields("BG_USER_XX").IsReadOnly=True

end if

Bug_Fields.Field("BG_USER_XY").IsReadOnly=True

9. Save the updatedWorkflow scripts.

10. Click theReturn button and return tomain ALM screen.

11. In the Customization Changes dialog box, select theMajor Change radio button and click OK.

Step 4: Creating a Filter in ALM

To create a defects filter that ALM Synchronizer uses to identify defects whose data
needs to be synchronized with Service Manager:

1. Log on to ALM with theSMALMIntUser integration account.

2. In theDefectsmodule, click View > Filter > Sort > Set Filters/Sort.
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Note: The purpose of this view is to make ALM Synchronizer correctly filter those defects to
be synchronized to ServiceManager as problems. If the implemented process requires a
more strict selection—for example, limit only defects in specific state—include those in the
filter as well.

3. Set Synchronize with SM Problem toY.

4. Add a view to Favorites:

n Name. Synchronize with SM Problem

n Location. Private

5. Log out.
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ALM Synchronizer
This section contains the following topics:

Installing ALM Synchronizer 157

Configuring ALM Synchronizer 157

Creating Synchronizer Link 159

Working with Field Mapping 164

Installing ALM Synchronizer

1. Download ALM Synchronizer from HP Live Network
(https://hpln.hp.com/group/synchronizer-content-alm) and extract the archive.

Note: This requires an HP Passport account with a User Name and Password.

2. Execute setup.exe to set up the ALM Synchronizer Server and follow the InstallationWizard. The
ConfigurationWizard opens.

3. Follow the ConfigurationWizard and provide the appropriate requested values for the environment
(for instance, details such as the ALM version number, system credentials to run as a service, and
so on).

4. ExecuteHP_ALM_Sync_Client_1.msi to set up the ALM Synchronizer client following the
InstallationWizard.

Note: The only input needed is the destination folder.

Configuring ALM Synchronizer

1. Download the content package for ALM Synchronizer from HP Live Network
(https://hpln.hp.com/page/defects-and-requirements-exchange-hp-service-
managerservicecenter-and-hp-alm) and extract the archive on the ALM Synchronizer machine.
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2. From theAdapters folder in the content package, copy the 10 .jar files to the ALM Synchronizer
installation folder under the adapters\lib directory.

3. Generate and deploy the stub:

a. Verify the ServiceManager service is up and running.

b. In the extracted files from the content package, locate and edit the build.properties file.
Update the sample URLwith actual values for the ServiceManager server host, port, and the
correspondingWeb service name (Web service endpoint configured in the ServiceManager
Configuration section).

For example,

http://<sm server host>:<sm server port>/SM/7/QCIntProblemService.wsdl

Validate that the URL is accessible from the ALM Synchronizer machine using aWeb
browser.

c. Restart the ALM Synchronizer service. This will extract the ServiceManager Problem
Management folder in the ALM Synchronizer install\adapters\dat folder.

d. Copy the configuration_file_default.xml example configuration file from the content
package\sample folder to theALM Synchronizer\adapters\SM ProblemManagement
folder and edit it according to the specific customer environment.

Note: Field types and allowed values for field lists may be significantly different from
out-of-the-box values.
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Formore details about configuration file editing, see “Editing the Configuration Files” in
Chapter 3, "Installing and Configuring QC/ALM Synchronizer" inHP Defects and
Requirements Exchange with HP ServiceManager/ServiceCenter and HP Quality
Center/Application Lifecycle Management Installation and Administration Guide.

Creating Synchronizer Link

In order to create a synchronizer link, install the ALM client and ALM connectivity tool from the ALM
add-ons page. Open the ALM Synchronizer client and connect to the synchronizer server.

To create a new synchronization link:

1. In themenu near the top of the screen, select Link > Create.

2. In theCreate Linkwizard, fill in the following values:

a. In the Step 1 of 4 –General Properties dialog box, enter the Link name andDescription
(optional). ForEndpoint 2 type, select SM ProblemManagement.

Click Next.
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b. In the Step 2 of 4 – HP-ALM Endpoint dialog box, enter the ALM connection details; including
theUser name andPassword, as well as theServerURL (in form of
http://<hostname>:<port>/qcbin), Domain, andProject.

Click Next.
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c. In the Step 3 of 4 – SM ProblemManagement Endpoint dialog box, enter the ServiceManager
connection details; including theUser nameandPassword, QC/ALM Project details (in the
form of <ALM hostname>/Domain/Project), WebService URL, as well as the edited
configuration.xml (Configuration File Name) from step 3.d of Configuration of ALM
Synchronizer.

Click Next.
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d. In the Step 4 of 4 – Entity Types dialog box, select the appropriate entity types. In the R2D
use case, the relevant entities areDefect on the ALM side andProblem by Defect on the
ServiceManager side.

e. Click Finish.
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3. Once the link is created, go to the Filters tab.

In the HP ALM section, select theUse filter (for creation events) radio button. In the drop-down
dialog box, select the favorite which was created in the ALM project configuration phase chapter.

4. Select theRules tab and verify that the entity creation rules are appropriate. The default
suggested rules are shown in the following figure:
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5. Select the Field Mapping tab andmap the fields between ALM Defect and SM Problem.

For complete details about this process, see Chapter 4, "Configuring Links in QC/ALM
Synchronizer" inHP Defects and Requirements Exchange with HP Service
Manager/ServiceCenter and HP Quality Center/Application Lifecycle Management Installation
and Administration Guide.

Working with Field Mapping

HP Defects and Requirements Exchange with HP ServiceManager/ServiceCenter and HP Quality
Center/Application Lifecycle Management Installation and Administration Guide shows the field
mapping chain. The fields which need to bemapped are different in each specific customer
environment, thus this process has to be done in each implementation project. For more information,
see Chapter 4, "Configuring Links in QC/ALM Synchronizer" in the document.

To work with Field Mapping:

1. Identify the required fields to create an ALM entity (Defect). In the out-of-the-box ALM
version 11.52 environment, the fields are:

Field name in ALM User Interface Field in ALM Database

Summary BG_SUMMARY

Detected By BG_DETECTED_BY

Severity BG_SEVERITY

Detected OnDate BG_DETECTION_DATE

2. Identify additional optional fields which provide value if synchronized from ALM to Service
Manager—Description, Defect status, and so on. This requires an appropriate modification of the
database schema, forms, andWeb service endpoint on the ServiceManager side.
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3. Identify the required fields to create a ServiceManager entity (Problem record). In Service
Manager version 9.32 (with ServiceManager Process Designer Content Pack installed), the fields
are:

Caption in SM User
Interface Field in SM Database

Caption in Web
Service Type

* Problem ID id SMProblemID StringType

** N/A sysmodtime Modified DateTimeType

Title brief.description Title StringType

Description description Description StringType

Affected Service affected.item AffectedService StringType

Impact initial.impact Impact StringType

Category category Category StringType

Area subcategory SubCategory StringType

Urgency severity Urgency StringType

* Synchronize with ALM qcintegration.type QCIntegrationType StringType

* Defect ID qcintegration.id QCEntityID IntType

* Server/Domain/Project qcintegration.project QCProject StringType

* Created From qcintegration.created.from CreatedFrom StringType

Those values can be provided as constant values (simple case) or mapped to a custom value list
in ALM.

* Not mandatory fields per say, but are required for enabling the integration.
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** This field captionmust be as shown in the following figure:

4. Identify additional optional fields that provide value if synchronized from ServiceManager to ALM
and add them to themapping. It is important to include:

SM web service
side Direction ALM Side Comment

ProblemID Problem ID Required for traceability
between the ALM Defect and
the SM Problem

QCEntityID Defect ID Required for traceability
between the SM Problem and
the ALM Defect

QCIntegrationType Constant value:1 Needed to lock the
appropriate fields on the SM
side
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SM web service
side Direction ALM Side Comment

QCProject Constant value: <ALM
hostname>/Domain/Project

Valuemust be one of the
values defined for the global
list in the Configuring Service
Manager > Step 3 > step 4.a.

CreatedFrom Constant value: ALM
Defect

Constant value: Y Synchronize with SM
Problem

5. Click Save to save the resulting link configuration.

6. A warning about an unvalidated link will appear. Click Yes to begin an integrity check. This is a
basic setup check that confirms that the fields configured as mandatory in both products are
mapped to values and field types that match.
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7. In case of a failed validation check, update themapping according to the error messages shown in
Run Report. To view the report, click theView Report button.

8. In themenu near the top of the screen, select Link > Enable Link.

The link is enabled.

9. In themenu near the top of the screen, select Run Task > Run Full Synchronization.

The synchronization task runs.
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Verification

Note: This procedure is to verify that the implementation was done successfully.

To validate the integration was set up successfully:

1. Log on to the ALM Client and create a defect:

a. Fill in themandatory fields and any optional fields which were added in the field mapping
phase.

b. Open a defect details form andmodify theSynchronize with SM Problem field toY.

2. Open the ALM Synchronizer client and run the Incremental Synchronization task. Review the
task execution result report. If at least one entity was created in an SM endpoint, proceed further.

3. Log on to ServiceManager.

a. In ProblemManagement, select Search Problem, and do a true search.

b. Go to the last Results page and review the latest problem records.

c. By referring to its title, locate the problem that was opened from ALM Defect () and review its
details. Verify that all mapped information has passed from ALM Defect to SM Problem.
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Chapter 10: Synchronizing CIs between UCMDB and
SM
This chapter includes:

Overview 170

Setting UpUCMDB for Integration with SM Using ServiceManagerAdapter9-x 171

Setting Up SM for Integration with UCMDB 175

Verification 176

Setting UpUCMDB for Integration with SM Using ServiceManagerAdapter7-1 177

Setting Up SM for Integration with UCMDB 180

Verification 182

Overview
This section describes the necessary steps to configure and verify the integration between
HP Universal CMDB (UCMDB) and HP ServiceManager (SM).

Typically, UCMDB uses one or more discovery mechanisms (feeders) to automatically detect
configuration item (CI) attribute values.

In the context of the Requirement to Deploy Value Stream, this integration allows the synchronization
of configuration data for managed services between UCMDB and ServiceManager. Having an up-to-
date state of the configuration is essential for managing associated change requests that are part of
deploying new ormodified services.

For more information, see Integration ID#101: CI sync and actual state federation (UCMDB to SM) in
HP Software Solutions Now.
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The following diagram illustrates the relationship between the products for this integration:

Setting Up UCMDB for Integration with SM Using
ServiceManagerAdapter9-x
This section describes the steps necessary to configure UCMDB in order to perform the integration
with SM using ServiceManagerAdapter9-x.

This section contains the following topics:

Prerequisites 172

Configuring SM Adapter in UCMDB 172

Creating a New Integration Point 173

Setting Up the Data Push Job 174

Running the Data Push Jobs 174
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Prerequisites

The following products must be installed:

l Log on to your UCMDB system as an administrator.

l Verify that all UCMDB services are running.

Configuring SM Adapter in UCMDB

To configure the SM adapter in UCMDB:

1. Browse to your UCMDB user interface.

2. Select theData Flow Management tab.

3. Select Adapter Management.

4. From the resources window, select ServiceManagerAdapter9-x and expand it.

5. Expand the configuration files item.

6. Select ServiceManagerAdapter9-x/sm.properties from the list of items.

7. In the pane on the right side of the window, modify the use.global.id parameter, set it to false,
and click OK.

Requirement to Deploy Concept and Configuration Guide
Chapter 10: Synchronizing CIs between UCMDB and SM

HP Value Stream (2.1) Page 172 of 256



Creating a New Integration Point

To create a new integration point:

1. Navigate toData Flow Management > Integration Studio.

2. In the Integration Point pane, click theCreate New Integration Point button. The Create
New Integration Point dialog box opens.

Enter the following information:

Name
Recommended
Value Description

Integration
Name

SM Integration Name you give to the integration point

Adapter <user defined> Select the appropriate adapter for the version of SM that you
are using

Is
Integration
Activated

selected Select this check box to create an active integration point

Hostname/IP <user defined> Name of the SM server

Port <user defined> Port through which you access SM

Credentials <user defined> If SM credentials appear in the Credentials column, select
them.

If no SM credentials appear, select Generic Protocol and
click theAdd new connection details for selected

protocol type button.

Enter the following information:

Description. EnterService Manager.

User Name. Enter the SM user name. The default value is
falcon.

User Password. Enter and confirm a password.

Probe Name <user defined> The probe is selected from a drop-down list. This is the
same probe that is being used for the UCMDB – BSM
integration.
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Note: It is recommended to click the Test Connection button to verify that the details
entered are working before continuing.

3. Click OK.

4. On the Federation tab, verify the Incident, Problem, andRequestForChangeCI types are

checked and click theSave Integration button.

Setting Up the Data Push Job

To push CIs and Relations from UCMDB to SM:

1. Edit theSM Push job.

2. Select Scheduler Definition.

3. For theRepeat field, select Changes Sync/All Data Sync.

4. Set theRepeat Every field to 1 Day.

5. Click OK.

Running the Data Push Jobs

To run the data push jobs:

1. In the Integration Point pane, select the correct integration.

2. Select theData Push tab. The Job Definition pane appears.

Note: The Changes jobmust be run before the RMI job.

3. Select your job and click Synchronize All to run the push job.

4. When the Confirm synchronizing window appears, click Yes.

5. Click theStatistics tab to view the progress of the synchronization.

6. Click Refresh to view the updated synchronization status.
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Setting Up SM for Integration with UCMDB
This section describes the steps necessary to configure SM in order to perform the integration with
UCMDB.

This section contains the following topics:

Prerequisites 175

Adding the UCMDB Connection Information to the System Information Record 175

Prerequisites

The following products must be installed:

l Log on to your UCMDB system as an administrator.

l Verify that all UCMDB services are running.

Adding the UCMDB Connection Information to the System
Information Record

To add the UCMDB connection information to the system information record:

1. Log on to your ServiceManager system as an administrator.

2. Navigate toSystem Administration > Base System Configuration > Miscellaneous >
System Information Record.

3. Select theActive Integrations tab.

4. Select theHP Universal CMDB option. The form appears in the UCMDBWeb service URL field.

5. In the UCMDBWeb service URL field, enter the URL to the UCMDBWeb service API.

The URL has the following format:

http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

6. In the UserId dialog box, enter yourUCMDB user name and password and click Save.
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Verification

Note: This procedure is to verify that the implementation was done successfully.

To verify the UCMDB – SM integration:

1. Browse to your UCMDB server.

2. Navigate toManagers > Modeling > CI Type Manager.

3. UnderConfigurationItem > InfrastructureElement, click Node.

4. Right-click a Node object and select Show CIT Instances. The CIT Instances window for the
selected Node object appears.

5. From the list of CIT instances, select one CI and right-click Properties. The Configuration Item
Properties window appears showing the UCMDB ID at the top of the window.

6. Click OK. The Configuration Item Properties window closes.

7. Click OK. The Show IT Instances window closes.

8. Browse to your SM server.

9. Navigate toConfiguration Management > Resources > Search CIs.

10. Click theSearch button.

11. Click More on selected CI.

12. SelectModify Columns.

13. Click the down arrow and select your UCMDB ID, then click Proceed.

14. Verify that all the CIs from UCMDB are listed in SM and select theActual State tab to view the CI
properties in UCMDB.
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Setting Up UCMDB for Integration with SM Using
ServiceManagerAdapter7-1
This section describes the steps necessary to configure UCMDB in order to perform the integration
with SM using ServiceManagerAdapter7-1.

This section contains the following topics:

Prerequisites 177

Configuring SM Adapter in UCMDB 177

Creating a New Integration Point 178

Setting Up the RMI Job 179

Setting Up the Changes Job 179

Running the Data Push Jobs 179

Prerequisites

The following products must be installed:

l Log on to your UCMDB system as an administrator.

l Verify that all UCMDB services are running.

Configuring SM Adapter in UCMDB

To configure the SM adapter in UCMDB:

1. Browse to your UCMDB user interface.

2. Select theData Flow Management tab.

3. Select Adapter Management.

4. From the resources window, select ServiceManager Adapter7-1 and expand it.

5. Expand the configuration files item.

6. Select ServiceManagerAdapter7-1/sm.properties from the list of items.

7. In the pane on the right side of the window, modify the use.global.id parameter, set it to false,
and click OK.
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Creating a New Integration Point

To create a new integration point:

1. Navigate toData Flow Management > Integration Studio.

2. In the Integration Point pane, click theCreate New Integration Point button. The Create
New Integration Point dialog box opens.

Enter the following information:

Name
Recommended
Value Description

Integration
Name

SM Integration Name you give to the integration point

Adapter <user defined> Select the appropriate adapter for the version of SM that you
are using

Is
Integration
Activated

selected Select this check box to create an active integration point

Hostname/IP <user defined> Name of the SM server

Port <user defined> Port through which you access SM

Credentials <user defined> If SM credentials appear in the Credentials column, select
them.

If no SM credentials appear, select Generic Protocol and
click theAdd new connection details for selected

protocol type button.

Enter the following information:

Description. EnterService Manager.

User Name. Enter the SM user name. The default value is
falcon.

User Password. Enter and confirm a password.
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Note: It is recommended to click the Test Connection button to verify that the details
entered are working before continuing.

3. Click OK.

4. On the Federation tab, select the Incident, Problem, andRequestForChangeCI types and

click theSave Integration button.

Setting Up the RMI Job

To replicate the relations from UCMDB to SM:

1. Edit theSM Topology Comparison Push job.

2. Select Scheduler Definition.

3. For theRepeat field, select interval.

4. Set theRepeat Every field to 1 Day.

5. Click OK.

Setting Up the Changes Job

To replicate CIs from UCMDB to SM:

1. Edit theSM History-based Push job.

2. Select Scheduler Definition.

3. For theRepeat field, select interval.

4. Set theRepeat Every field to 1 Day.

5. Click OK.

Running the Data Push Jobs

To run the data push jobs:

1. In the Integration Point pane, select the correct integration.

2. Select theData Push tab. The Job Definition pane appears.
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Note: The Changes jobmust be run before the RMI job.

3. Select your job and click Synchronize All to run the replication job.

4. When the Confirm synchronizing window appears, click Yes.

5. Click theStatistics tab to view the progress of the synchronization.

6. Click theRefresh button to view the updated synchronization status.

Note: Follow the same procedure for the RMI and Changes jobs.

Setting Up SM for Integration with UCMDB
This section describes the steps necessary to configure SM in order to perform the integration with
UCMDB.

This section contains the following topics:

Prerequisites 180

Adding the UCMDB Connection Information to the System Information Record 180

Prerequisites

The following products must be installed:

l Log on to your UCMDB system as an administrator.

l Verify that all UCMDB services are running.

Adding the UCMDB Connection Information to the System
Information Record

To add the UCMDB connection information to the system information record:

1. Log on to your ServiceManager system as an administrator.

2. Navigate toSystem Administration > Base System Configuration > Miscellaneous >
System Information Record.

3. Select theActive Integrations tab.
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4. Select theHP Universal CMDB option. The form appears in the UCMDBWeb service URL field.

5. In the UCMDBWeb service URL field, enter the URL to the HP Universal CMDBWeb service
API.

The URL has the following format:

http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

6. In the UserId dialog box, enter yourUCMDB user name and password and click Save.
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Verification

Note: This procedure is to verify that the implementation was done successfully.

To verify the UCMDB – SM integration:

1. Browse to your UCMDB server.

2. Navigate toManagers > Modeling > CI Type Manager.

3. UnderConfigurationItem > InfrastructureElement, click Node.

4. Right-click a Node object and select Show CIT Instances. The CIT Instances window for the
selected Node object appears.

5. From the list of CIT instances, select one CI and right-click Properties. The Configuration Item
Properties window appears showing the UCMDB ID at the top of the window.

6. Click OK. The Configuration Item Properties window closes.

7. Click OK. The Show IT Instances window closes.

8. Browse to your SM server.

9. Navigate toConfiguration Management > Resources > Search CIs.

10. Click theSearch button.

11. Click More on selected CI.

12. SelectModify Columns.

13. Click the down arrow and select your UCMDB ID, then click Proceed.

14. Verify that all the CIs from UCMDB are listed in SM and select theActual State tab to view the CI
properties in UCMDB.
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Chapter 11: Viewing Agile Manager Release
Information in PPM
This chapter includes:

Overview 183

Configuring Agile Manager Integration Options 184

Adding an Agile Integration Configuration 185

Configuring PPM Center Project 186

Mapping a PPMCenter Task to Agile Manager 187

Overview
The integration between HP Project and Portfolio Management (PPM) Center and HP Agile Manager
(AgM) software can give you the information you need tomake better business decisions, lower the
cost of running both your Agile and traditional development projects, increase collaboration between
business and IT, and improve application quality. Wewill explore how Agile development can be
aligned with the basic principles of Project and Portfolio Management to make sure that IT objectives
meet the company’s business goals.

PPM Center integrates with Agile Manager using the HP PPM Plug-in for Agile integration. The
integration between PPMCenter and Agile Manager allows project managers, programmanagers,
portfolio managers, and other project stakeholders to have:

l Visibility into the real-time status and progress of Agile development projects from within PPM
Center, without having to log on to Agile Manager for details;

l A consolidated view of their tasks and Agile development initiatives

The integration allows project managers tomap a task under a project to a specific releasemanaged in
Agile Manager. Each PPMCenter task is associated with a single release in Agile Manager throughout
the task life cycle. This is a one-way one-to-onemapping relationship. This association begins when a
project manager maps one task to a specific release.

After themapping relationship is established, the project managers are able to view real-time Agile
development related charts retrieved from Agile Manager. In addition, project managers can also view
the overall release hierarchy information of a specific work package from within PPM Center.

For more information, see Integration ID#634: Agile Integration Solution (PPM –Agile Manager) in
HP Software Solutions Now.
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The following diagram illustrates the relationship between the products for this integration:

Configuring Agile Manager Integration Options

To configure the Agile Manager integration options:

1. Download and install the HP PPM 9.22 Plug-in for Agile Integration. Obtain the plug-in bundles
from HP Live Network:

a. Go to the PPMCommunity on HP Live Network.

b. On the PPMCommunity home page, click Content Catalog.

c. Click Agile Manager Integration Plug-in for PPM (where HP is the provider).

d. Click Downloads.

TheAgile Manager Integration Plug-In for PPM – Downloads page opens.

e. Click theHP Agile Manager Connector for PPM 9.30 folder.

f. Click ppm-930-AgileManagerConnector.zip to download the package. This package
contains the ppm-930-Connector-AGM.jar bundle.

2. Stop the PPM Server.

a. In the PPM Server, open a command line.

b. Go to the <PPM home>\bin folder.

c. Run the following script: sh kStop.sh -now -user <admin_user>

3. Unzip the package and copy the bundle to the <PPM_Home> directory.
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4. Deploy the bundle by running the following command from the <PPM_Home>/bin directory:

n sh ./kDeploy.sh -i Connector-AGM

5. Start PPM Server.

a. In the PPM Server, open a command line.

b. Go to the <PPM home>\bin folder.

c. Run the following script: sh kStart.sh

Adding an Agile Integration Configuration

To add an Agile integration configuration:

1. Log on to PPM Center with administrative privileges.

2. From themenu bar, select Open > Administration > Integrations.

3. In the navigation pane, click theHybrid Project tab.

4. In the Instances section, to the right of HP Agile Manager 1.0, click +.
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5. Complete the fields described in the following table:

Field
(Required) Description

*Instance
Name

Specify a unique name for the target Agile Manager server

*Base URL URL of the HP Agile Manager server you want to integrate with

Format of the URL: http(s)://<agile_server_address>:<port>

*Proxy Host Host name of the proxy if you have configured the proxy for the PPM Server to
access the Internet

Proxy Port Port of the proxy if you have configured the proxy for the PPM Server to access
the Internet

Use Global
Proxy

Flag whether or not to use the proxy specified in the parameter HTTP_PROXY_
URL.

For more information, see "Configuring Global Proxy" on page 112 of the HP
Solution and integration Guide for PPM version 9.30.

6. Click Save.

Configuring PPM Center Project
In order to map a PPMCenter task to an Agile Manager project, the project to which the task belongs
must be set as a Hybrid Project.

To set the task as a Hybrid Project:

1. Log on to PPM Center.

2. From themenu bar, select Search > Projects.

TheSearch Projects page opens.

3. Locate and open the desired project.

In the upper right-hand corner of theProject Overview page, click Settings.

4. In the left-hand pane, click theHybrid Project tab.

5. Select theSet the current project as a Hybrid Project option.

6. Click Done. The setting is saved.
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Mapping a PPM Center Task to Agile Manager

Note: This procedure is for validation only. It is not mandatory for an R2D configuration.

To associate an Agile release as a sub-project to a PPM Center task:

1. Log on to PPM Center with administrative privileges.

2. From themenu bar, select Search > Projects. TheSearch Projects page opens.

3. Locate and open the desired project.

4. On theProject Summary tab of theProject Overview page, click Edit Work Plan in theWork
Plan portlet.

TheWork Plan for <Project_Name> page displays.

5. Open the Task Details page for the desired task that you want to associate to, and go to the
Hybrid Project tab.

6. Select Start Mapping.

TheHybrid Project section displays Step 1: Select Instance.
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7. From theSelect Instance drop-down list, select an instance of the appropriate agile project with
the Agile Manager icon in front of the instance name.

8. Click Next andmove toStep 2: User Configuration.

9. In theUsername andPassword fields, enter the user name and password that you use to log on
to Agile Manager.

10. Select a value from the drop-down list for each of theDomain, Project, andRelease fields.

11. After themapping relationship is established, select the charts you want to display in theHybrid
Project the following options:

n Show Sprint Burn DownChart

n Show Release Burn DownChart

n Show Theme Status Chart

n Show Feature Status Chart

12. Click Next.

13. Themapping process moves toStep 3: Confirmation, displaying the information you provided in
the User Configuration step. Click Submit.
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Themapping relationship is established.The Agile Manager connector icon appears in theOverall
Status section of theProject Overview page, indicating that the project has tasks mapped to
agile projects.
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Chapter 12: Associating UCMDB Service CI with PPM
Entities
This chapter includes:

Overview 190

Configuring PPM andUCMDB 191

Adding a Service Context from UCMDB to PPM 201

Verification 205

Overview
For service portfolio functionality, services can be associated with the Service field in HP Project and
Portfolio Management (PPM) Center requests, and then labor costs can be tracked for each service.
The list of services can be retrieved from HP Universal CMDB (UCMDB) in real time.

The primary goal of the Service concept is to have a place in PPM that allows users to identify the
service that work is being performed against. User can specify a service attribute in a request. The
service attribute is from a service list, which can be configured to be discovered from the UCMDB
application in real time. From the perspective of PPM, we just need to retrieve a configuration item (CI)
list of a certain CI type from UCMDB through a web service interface (SOAP) provided by UCMDB.

In the context of the Requirement to Deploy (R2D) Value Stream, this integration provides a service
context for a PPM project. This service context can also be transferred to SM when submitting a
request for change (RFC) from awork plan. For more information, see Integration ID#370: Retrieve
Service List (PPM –UCMDB) inHP Software Solutions Now.
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The following diagram illustrates the relationship between the products for this integration:

Configuring PPM and UCMDB
This section contains the following steps:

Step 1: Editing the PPM server.conf Configuration File 191

Step 2: Creating a Request Type Header with the Service Field 193

Step 3: Creating a Request Type That Uses the New Request Header Type 196

Step 4: Setting UpUCMDB CI Type Properties 199

Step 1: Editing the PPM server.conf Configuration File

1. Log on to the PPM server.

2. Stop the PPM Server.

a. Log on to the PPM server as an administrator and open a command line.

b. Go to the <PPM home>\bin folder.
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c. Run the following script: sh kStop.sh -now -user <admin_user>

Note: <admin_user> is a PPM user with administrative privileges.

3. Configure the server.conf file.

a. In the PPM Server, go to the <PPM home> folder.

b. Back up and edit the server.conf file in as follows:

If not already present, add and specify the parameters and values related to the Service
Manager integration to the PPMCenter server.conf configuration file, as shown in the
example file below. Set the parameters in the example tomatch your environment.

Note: Formore information on each parameter, see page 323 in Chapter 9 of theHP PPM
Solution and Integration Guide.

The password for the UCMDB user is specified in UCMDB_WS_PASSWORD. Youmust
encrypt this password using the kEncrypt.sh script that is located in the bin directory of the
PPM Server.

The parameters can be customized. For example, you can select another CIT.

Note: In this example, the parameter com.kintana.core.server.SERVICE_LIST_
UCMDB_CI_TYPE=business_servicemeans the integration will use a CI-Type business
service from UCMDB.

For more information, see Chapter 9 of theHP PPM Solution and Integration Guide.

#

#

com.kintana.core.server.SERVICE_LIST_SOURCE=uCMDB

#

#

com.kintana.core.server.SERVICE_LIST_UCMDB_CACHE_TIMEOUT=300

#

#

com.kintana.core.server.SERVICE_LIST_UCMDB_CI_
MAPPINGS=name:name,description:description

#
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#

com.kintana.core.server.SERVICE_LIST_UCMDB_CI_TYPE=business_service

#

#

com.kintana.core.server.SERVICE_LIST_UCMDB_MAX_CI_NUMBER=1000

#

#

com.kintana.core.server.UCMDB_SERVER_VERSION=10

#

#

com.kintana.core.server.UCMDB_GATEWAY_URL=http://<UCMDB URL
FQDN>:8080/mam/gateway?

#

#

com.kintana.core.server.UCMDB_SERVER_URL=http://<UCMDB URL FQDN>:8080/ucmdb/

#

#

com.kintana.core.server.UCMDB_WS_MAX_CONNECTION_NUMBER=10

#

#

com.kintana.core.server.UCMDB_WS_PASSWORD=<ucmdb admin user password>

#

#

com.kintana.core.server.UCMDB_WS_USER=<ucmdb admin user>

Step 2: Creating a Request Type Header with the Service Field

1. Log on to PPM Center with administrative privileges.

2. In PPM Center, click Open > Administrator > Open Workbench.

3. In the workbench:

a. Go toDemand Mgmt.

b. Click Request Header Types.
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c. In the Request Header TypeWorkbench dialog box, click New Request Header Type.

d. In the new Request Header Type dialog box, do the following:

i. Enter theRequest Header Type Name—for example, Service.

ii. Click theReference Code field.
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iii. Click the Field Groups button.

iv. In the Field Groups dialog box, select theService field group.

v. Click OK.

vi. Double-click theService field in the Request Header Type dialog box and confirm the
validation for this field is Service List UCMDB.
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Note: This validation is an autocomplete list. When users select autocomplete for
the Service field, this validation invokes a special command to retrieve the Service
list from Universal CMDB.

As with any request field, the administrator canmake the Service field optional or
required.

vii. Click OK.

viii. Click OK.

Step 3: Creating a Request Type That Uses the New Request Header
Type

1. In PPM Center, click Open > Administrator > Open Workbench.

2. In the workbench:

a. Go toDemand Mgmt.

b. Click Request Types.
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c. In the Request TypeWorkbench dialog box, click New Request Type.

d. In the New Request Type dialog box, do the following:

i. Request Type Name. Select a name for the request type—for example, Service
Request.
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ii. Request Header Type. Click theSelection icon. The Validate dialog box opens.
Select Service and click OK.
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iii. Confirm that Service field is being added and click OK.

Note:When users create a request of that new request type and click the autocomplete for
the Service field, the service list options are retrieved from Universal CMDB at that time.

Step 4: Setting Up UCMDB CI Type Properties

In UCMDB, theName attribute of the CI Typemust be a key attribute.

To confirm that the Name attribute is defined as a key attribute:

1. Open the UCMDB user interface with administrative privileges.

2. Go to theCI Type Manager.
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3. Select the CI Type you are using for your service list—for example, business_service.

4. Go toAttributes andmake sure that theName attribute is marked as the key attribute:

If the Name attribute is not defined as a key attribute, define it as a key attribute.

To define the Name attribute as a key attribute:

1. Go to theDetails tab.

2. In the Identification dialog box, change the default identification toBy key attributes.

Caution: Note the identification that is defined before changing it since you will need to
change it back to this identification after the procedure.

3. In the Available Attributes dialog box, select Name as the key attribute.

4. Click Save.

5. In the Identification pane, change the identification back to whatever the default was before
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changing it in Step 2.

Note: The original out-of-the-box default value wasBy identification rule.

6. Click Save.

Adding a Service Context from UCMDB to PPM
This section contains the following steps:

Step 1: Adding a Service Field from UCMDB to a PPM Project 201

Step 2: Adding a Service Field from UCMDB to a PPM Task 203

A Service context can be added from UCMDB to a PPM project, task, or request for change (RFC).

Step 1: Adding a Service Field fromUCMDB to a PPM Project

Note: The followingmust be configured after configuring integration ID#370 as described in
"Configuring PPM andUCMDB" on page 191.

1. Log on to PPM Center as a user with administrative privileges.

2. In the PPMCenter, navigate toOpen > Administrator > Open Workbench.

3. In the workbench, go toDemand Mgmt.

4. Select Request Header Types.

5. In the Request Header TypeWorkbench window, click List.
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6. In theResults tab, double click Project Details Request Header Type.

7. In the Request Header Type: Project Details window, click Field Groups.

8. Select theService field and click OK.

9. Click Save.

10. Click OK.
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Step 2: Adding a Service Field fromUCMDB to a PPM Task

Note:

l This should be configured for each project separately and does not apply for all PPM projects.

l "Step 2: Add a Service field from UCMDB to a PPM task" can only be configured after "Step 1:
Adding a Service Field from UCMDB to a PPM Project" on page 201.

1. Log on to PPM Center as a user with administrative privileges

2. From the Search Projects window, search and open your project.

3. Within the project, select Settings.
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4. In the Project Settings window, Project Fields pane, Additional Fields section, select Service.

5. Click Save.

6. Click Done.
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Verification

Note: These procedures are to verify that the implementations were done successfully.

Caution: These verifications must be done in this order.

To verify that the Service field was added to the PPM Project:

1. Log on to PPM Center as a user with administrative privileges.

2. Navigate toSearch > Projects.

3. From the Search Projects window, search and open your project.

4. Within the project, go to theProject Details tab.

5. Confirm that theService field exists and that you can use it to add CIs from UCMDB.

a. In theService field, click theChoose Services button on the right-hand side of the field.

b. Confirm that you can select service CIs from UCMDB.

To verify that UCMDB CIs can be added to a PPM task:

1. In PPM, navigate toSearch > Projects.

2. Search for and select your project.

3. In theProject Summary, click Edit Work Plan.

4. Double-click the task to which you want to add the UCMDB Service CI.

5. In the new Service field, click theChoose Service button.
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6. Verify that the services in the list are the CIs from UCMDB that you wish to integrate with PPM,
and select a service.

7. Click Save.

8. Confirm that the service was successfully added to theService field and click Done.
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Chapter 13: Creating an SM RFC from PPM Project
Task
This chapter includes:

Overview 207

PPM –SM: Creating RFC fromWork Plan 208

Verification 226

Overview
This solution integrates Project and Portfolio Management (PPM) Center project tasks with Service
Manager (SM) Requests For Change (RFCs) to allow PPMCenter project managers to specify which
tasks in a project, if any, automatically create corresponding RFCs in ServiceManager. Then PPM
Center project managers can track the status of the corresponding RFCs in PPM. As the RFCs are
completed in ServiceManager, the statuses of the associated PPMCenter tasks are automatically set
toComplete. If the RFCs are rejected in ServiceManager, the associated tasks in PPM are set to
Canceled.

In the context of the Requirement to Deploy (R2D) Value Stream, this integration enables the
traceability between a project and a set of RFCs associated with it.

For more information, see Integration ID#255: Create RFC from work plan (PPM –SM) in
HP Software Solutions Now.
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The following diagram illustrates the relationship between the products for this integration:

PPM – SM: Creating RFC from Work Plan
To configure this integration, perform the following steps in Project and Portfolio Management (PPM)
Center and ServiceManager (SM). Youmust have system administrator privileges in both PPM Center
and ServiceManager.

This section contains the following steps:

Step 1: Configuring the PPMCenterWeb Services Configuration 209

Step 2: Adding Task ID Field to SM Database Dictionary 209

Step 3: Configuring the IntegrationMapping XML File 211

Step 4: Adding Fields for the Integration to the ChangeManagement WSDL 218

Step 5: Importing the PPMUNL Files to SM 219

Step 6: Editing JavaScript for Correct Host and Port for PPM Center 220

Step 7: Starting the ppmfailover Scheduler in ServiceManager 221

Step 8: Configuring the server.conf File in PPM 222

Step 9: Enabling RFC Creation for a PPM Center Project 223

Step 10: Modifying the ServiceManager Scripts 224
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Step 1: Configuring the PPM Center Web Services Configuration

1. Stop the PPM Server.

a. Log on to the PPM Server as an administrator.

b. Open a command line.

c. Go to the <PPM home>\bin folder.

d. Run the following script: sh kStop.sh -now -user <admin_user>

Note: <admin_user> is a PPM user with administrative privileges.

2. Check the PPMCenterWeb services configuration. Confirm that the basic authenticationmode is
enabled.

a. Log on to the PPM Server as an administrator.

b. Open the configuration file located at <PPM_Home>\server\<PPM_Server_
Name>\deploy\itg.war\WEB-INF\conf\axis2.xml.

c. Check that <PPM_Server_Name> is the name or IP address of your PPM Center instance.

d. Confirm that the value of InFlowBasicAuth is true.

3. Start the PPM Server.

a. Open a command line.

b. Go to the <PPM home>\bin folder.

c. Run the following script: sh kStart.sh

Step 2: Adding Task ID Field to SM Database Dictionary

1. Log on to the ServiceManager console as an administrator.

2. In the ServiceManager command line, enter dbdict.
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3. Press Enter.

The Database Dictionary screen opens.

4. In the File Name field, enter cm3r and click Search.

5. Select cm3r in the File Name section.

6. Click theName column of the descriptor row.

7. Click New Field/Key.

The field.window opens.

8. In the Name field, enter taskId.

9. From the Type drop-down list, select number.

10. Click theAdd Field icon.

The field is added to the dbdict.
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11. Locate and double-click the taskId field.

12. In the field.window that opens, enter the following:

Table Field Value

SQL Name TASKID

SQL Type FLOAT

Note: Youmay also chooseVARCHAR2(400).

SQL Table m1

13. Click OK.

14. After confirmation of the SQL statements, click SM Alters.

Step 3: Configuring the Integration Mapping XML File

1. Log on to the PPM Server as an administrator.

2. Go to the <PPM_Home>\conf\smrfc directory.

3. Copy the sm-rfc-mapping.xml.sample field mapping file and paste it in the same directory.
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Note: You should have two files in the same directory with a different name.

4. Rename the copied file to sm-rfc-mapping.xml.

5. Customize the xml file. For R2D, we recommend customizing themapping file in the following
way:

Note: You can choose to alter the fields and values according to specific requirements. For
more information, see "Integrating PPM Center Tasks with HP ServiceManager RFCs" on
page 303 in Chapter 8 of theHP Project and Portfolio Management Center - HP Solution
Integrations Guide.

Caution: In the new mapping file, verify that the Status field in ServiceManager is set to
initial. This value will bemaintained by ServiceManager after the change record is created in
ServiceManager. Do not edit this field.

Here is an example of the xml file. It is recommended to use or edit this xml for the R2D
environment.

Note: The fields in themapping file are case-sensitive.

<?xml version="1.0" ?>

<PPMSMIntegration>

<SMRFCMapping>

<field>

<smField>PPMTaskId</smField>

<ppmField>TASK_ID</ppmField>

<useOnCreate>true</useOnCreate>

<useOnUpdate>true</useOnUpdate>

</field>

<field>

<smField>BriefDescription</smField>

<ppmField>TASK_NAME</ppmField>

<useOnCreate>true</useOnCreate>

<useOnUpdate>true</useOnUpdate>
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</field>

<field>

<smField>ExtProjectRef</smField>

<ppmField>PROJECT_REQUEST_ID</ppmField>

<useOnCreate>true</useOnCreate>

<useOnUpdate>false</useOnUpdate>

</field>

<field>

<smField>Description</smField>

<ppmField>TASK_DESCRIPTION</ppmField>

<useOnCreate>true</useOnCreate>

<useOnUpdate>true</useOnUpdate>

<defaultValue>ppm task does not have a description</defaultValue>

</field>

<field>

<smField>EffectOfNotImplementing</smField>

<useOnCreate>true</useOnCreate>

<defaultValue>Unavailable</defaultValue>

</field>

<field>

<smField>RequestedDate</smField>

<ppmField>TASK_SCHEDULED_END_DATE</ppmField>

<useOnCreate>true</useOnCreate>

<useOnUpdate>true</useOnUpdate>

</field>

<field>

<smField>RequestedBy</smField>

<useOnCreate>true</useOnCreate>

<defaultValue>FALCON, JENNIFER</defaultValue>

</field>

<field>
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<smField>Reason</smField>

<useOnCreate>true</useOnCreate>

<defaultValue>business</defaultValue>

</field>

<field>

<smField>Category</smField>

<useOnCreate>true</useOnCreate>

<defaultValue>Normal Change</defaultValue>

</field>

<field>

<smField>Subcategory</smField>

<useOnCreate>true</useOnCreate>

<defaultValue>Major</defaultValue>

</field>

<field>

<smField>ChangeCoordinator</smField>

<useOnCreate>true</useOnCreate>

<defaultValue>CHANGE</defaultValue>

</field>

<field>

<smField>ChangeOwner</smField>

<useOnCreate>true</useOnCreate>

<defaultValue>CHANGE</defaultValue>

</field>

<field>

<smField>AssignmentGroup</smField>

<useOnCreate>true</useOnCreate>

<defaultValue>Application</defaultValue>

</field>

<field>

<smField>InitialAssessment</smField>
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<useOnCreate>true</useOnCreate>

<defaultValue>1 - Enterprise</defaultValue>

</field>

<field>

<smField>Urgency</smField>

<useOnCreate>true</useOnCreate>

<defaultValue>2 - High</defaultValue>

</field>

<field>

<smField>Emergency</smField>

<useOnCreate>true</useOnCreate>

<useOnUpdate>true</useOnUpdate>

<defaultValue>false</defaultValue>

</field>

<field>

<smField>Status</smField>

<useOnCreate>true</useOnCreate>

<useOnUpdate>true</useOnUpdate>

<defaultValue>initial</defaultValue>

</field>

</SMRFCMapping>

</PPMSMIntegration>

6. Add aService context to be integrated in ServiceManager from PPM.

Note: The following can only be configured AFTER completing:

n Chapter 10, Integration ID#101 according to "Synchronizing CIs between UCMDB and
SM" on page 170

n Chapter 12, "Adding a Service Context from UCMDB to PPM" on page 201
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Caution:

n Be sure that ServiceManager is synced with UCMDB and appropriate CIs that exist in
UCMDB also exist in ServiceManager.

n If the CI (service) that the RFC is being opened with does not exist in ServiceManager,
the RFC will not be created and the PPM users will not be notified that the RFC creation
failed.

a. Edit the sm-rfc-mapping.xml file, and add the following field:

<field>

<smField>Service</smField>

<ppmField>TASK_SERVICE</ppmField>

<useOnCreate>true</useOnCreate>

<defaultValue>Applications</defaultValue>

</field>

The property values are described as follows:

Field Elements Values Description

smField Service Service field in the SM RFC

ppmField TASK_SERVICE Service that is associated with
the PPM task that the RFC is
being opened from

useOnCreate true Indicates if the service will be
synced when opening an RFC

defaultValue Applications If the service field is empty for the
task which opens the RFC, this
value (Applications) will be
synced into the SM service field.
This field can bemodified as long
as the service does exist in SM.

b. Save the file.
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7. Make sure that the ServiceManager fields specified in the field mapping file are exposed through
the ChangeIIA object in the ChangeManagement Web service in ServiceManager.

a. Log on to ServiceManager as an administrator.

b. SelectMenu Navigation > Tailoring > Web Services > Web Services Configuration.
TheExternal Access Definition page opens.

c. In theService Name field, enterChangeManagement and click Search.

d. In the object.name section, select ChangeIIA.

e. In theExternal Access Definition section, select the Fields tab.

f. Check that all of the fields that are used in themapping xml file (sm-rfc-mapping.xml) are
listed on the Fields tab of theChangeIIA object (for the cm3r table) in the
ChangeManagement Web service. If any field is not listed, add the field name and caption
name to the Field andCaption columns.

For details on how to expose the fields of a table through a ServiceManagerWeb service, see
theService Manager Online Help.
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Step 4: Adding Fields for the Integration to the ChangeManagement
WSDL

1. Log on to ServiceManager as an administrator.

2. SelectMenu Navigation > Tailoring > Web Services > Web Services Configuration. The
External Access Definition page opens.

3. In theService Name field, enterChangeManagement and click Search.

4. In the object.name section, select ChangeIIA.

5. In theExternal Access Definition section, select the Fields tab.

6. Scroll down to the bottom of the form, and click the next available line.

7. Enter the following fields in the last row:

Table Field Value

Field taskId

Caption PPMTaskId Note:

Note: This caption will be exposed toWSDL andmust match the
smField name defined in the sm-rfc-mapping.xml file.

Type StringType

After entering the data, a new row is created.

8. Enter the following fields in the new last row:

Table Field Value

Field header,foreign.id

Caption ExtProjectRef

Type StringType
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Step 5: Importing the PPM UNL Files to SM

The following unload files are provided with PPM Center (present in the <PPM_Home>\conf\smrfc
directory):

l PPMIntegration.unl (the integration unload file)

l PPMIntegration_Schedule.unl (the ppmfailover schedule object file)

Note:

l If you are using anOracle database with ServiceManager, loading of the PPMIntegration.unl
file might fail the first time. Reloading the file could solve the problem.

l If you load the PPMIntegration_Schedule.unl file more than once, duplicate ppmfailover
schedules will be created in ServiceManager. In this case, delete the redundant ppmfailover
schedules.

1. Import/load the unload files provided with PPM Center.

a. Log on to ServiceManager as system administrator.

b. Enter db in the ServiceManager command line and press Enter. The DatabaseManager pane
opens.

c. Right click in the DatabaseManager pane, click theMore drop-down arrow, and select
Import/Load from the context menu. The HP ServiceManager File Load/Import pane opens.

d. In the File Name field, specify the file to load: <PPM_
Home>\conf\smrfc\PPMIntegration.unl.

e. Click Load FG. A message stating that the records have been loaded displays.

f. Click Back.

g. Repeat the steps for thePPMIntegration_Schedule.unl file.

2. Configure the integration table in ServiceManager.

a. Enter db in the ServiceManager command line and press Enter. The DatabaseManager pane
opens.

Requirement to Deploy Concept and Configuration Guide
Chapter 13: Creating an SM RFC from PPM Project Task

HP Value Stream (2.1) Page 219 of 256



b. Select ppmIntegration from the Table drop-down list and click Search. The form for the
ppmIntegration table displays.

Note: If the ppmIntegraion does not exist in the drop-down list, log out and log back in to
ServiceManager.

c. Add the following new record to the table:

Table Field Value

Id 1

Field to Store TaskId Value of this field must match the field name
you previously added to the cm3r table for the
PPMCenter task ID (see Step 8 "In the
Name field, enter taskId." on page 210).

For example,

taskId

Note: If the case-sensitive field names
do not match, the integration will fail.

PPM Server URL URL of the PPMCenterWeb services

For example,

http://<Host_Name>:<Port>/itg/
ppmservices/

PPM Server Username User name that ServiceManager uses to call
the PPM CenterWeb services. This user
namemust include only single-byte
characters. HP recommends that you create
a separate user account for this purpose.

PPM Server Password Password of the user name that Service
Manager uses to call the PPM CenterWeb
services

Step 6: Editing JavaScript for Correct Host and Port for PPM Center

1. Log on to the ServiceManagerWeb tier with administrative privileges.

2. SelectMenu Navigation > Tailoring > Script Library.
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3. In theName field, enter Integration.

4. Click Search. The IntegrationService script opens.

5. Find the line that contains the URL for the PPM instance. The line should begin with
this.location = new String.

6. Set the URL to http://<Host_Name>:<Port>/itg/ppmservices/IntegrationService.

Note: <Host_Name> and <Port> are for connecting to PPM.

The line should look as follows:

this.location = new String("http://<Host_
Name>:<Port>/itg/ppmservices/IntegrationService")

7. Click Save, then click Compile.

8. Click Cancel and return to the Search pane.

9. ForProject, repeat steps 3 through 8, but instead of searching for Integration in step 3, enter
Project and set the URL in step 6 to http://<Host_
Name>:<Port>/itg/ppmservices/ProjectService.

Note: <Host_Name> and <Port> are for connecting to PPM.

Step 7: Starting the ppmfailover Scheduler in Service Manager

Note: By default, theRepeat Interval of the ppmfailover schedule is one hour.

You can change the default Repeat Interval to another value. However, do not change other field
values.

1. Start the ppmfailover scheduler in ServiceManager.

a. Log on to the ServiceManagerWeb tier with administrative privileges.

b. In SM, enter status in the command line.

c. Click Start Scheduler.

2. Select the ppmfailover scheduler.
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Step 8: Configuring the server.conf File in PPM

1. Log on to PPM server.

2. Stop the PPM server.

a. Open a command line.

b. Go to the <PPM home>\bin folder.

c. Run the following script: sh kStop.sh -now -user <admin_user>

Note: <admin_user> is a PPM user with administrative privileges.

3. Configure the server.conf file.

a. In the PPM Server, go to the <PPM home> folder.

b. Back up and edit the server.conf file in the following way:

If the parameters are present, edit them according to the following table. If they are not
present, add them.

Parameter Description, Value

com.kintana.core.server.SM_RFC_
INTEGRATION_ ENABLED

Setting the parameter to true enables SM RFC
integration with PPM Center

com.kintana.core.server.SM_
USERNAME

User name that PPM Center uses to access
ServiceManager. This user namemust include
only single-byte characters—for example, admin.

com.kintana.core.server.SM_
PASSWORD

Password that PPM Center uses to access
ServiceManager. Youmust encrypt this password
by using the kEncrypt.sh script, which is located
in the bin directory of the PPM Server. Then
remove #!# from the beginning and the end of the
encrypted password.

com.kintana.core.server.SM_URL Host name or IP address of ServiceManager

For example,

http://<Host_Name>:13080
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Parameter Description, Value

com.kintana.core.server.SM_
WEB_URL

Address of ServiceManagerWeb tier

For example,

http://<Host_Name>:<Port>/<WebTier_
Package_File_Name>/index.do

To obtain the Service Manager Web tier URL:

1. Log on to ServiceManager as System
Administrator.

2. Click Navigation > System Administration >
Base System Configuration > Miscellaneous >
System Information Record.

3. Click Active Integrations and get the
WebServer URL value. By default, it would be
http://<Host_Name>:13080/sm/ index.do.

com.kintana.core.server.ENABLE_
WEB_ SERVICES

Setting the parameter to true enables web services

4. After saving the server.conf file, start the PPM Server.

a. Open a command line.

b. Go to the <PPM home>\bin folder.

c. Run the following script: sh kStart.sh

Step 9: Enabling RFC Creation for a PPM Center Project

If the RFC creation capability is enabled for the project type used by a project, the RFC creation
capability is, by default, enabled for the project when it is created.

To enable the RFC creation capability if it is not enabled for a project:

1. Log on to PPM Center with administrative privileges.

2. Open your project in PPM Center.

3. On the Project Overview page, click Project Settings.
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4. In the list of policies, click HP Service Manager.

The HP ServiceManager policy opens.

5. If theEnable RFC creation capability check box is not selected but you can select it, select it. If
you cannot select it, see "Integrating PPM Center Tasks with HP ServiceManager RFCs" on
page 312 in Chapter 8 of theHP PPM Solution and Integration Guide.

Step 10: Modifying the Service Manager Scripts

Before youmodify the ServiceManager Processes that call the PPM CenterWeb services to update
the RFC status and task status, add the following code to the Final JavaScript tab of each process:

if(vars.$L_exit!="bad.val")

system.library.HPPPMSMIntegration.integratePPM();

Note: The code is added to the cm.close, cm.reject, cm.update.save, and cm.next.phase
processes when you load the PPMIntegration.unl file. The standardSave, Close, Reject, Next
Phase, andReopen actions for RFCs invoke these processes. If you have added any other
actions used to update changes (through tailoring of your ServiceManager instance), youmust
alsomodify the processes that these self-defined actions will invoke.
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To modify the Service Manager Processes:

1. Log on to ServiceManager as System Administrator.

2. SelectMenu Navigation > Tailoring > Document Engine > Processes.

The Process Definition search screen appears.

3. Click Search.

4. In theProcess Name field, enter cm.close.

5. In theProcess Definition section, click the Final JavaScript tab.

6. Add the following code to the end of the line:

if(vars.$L_exit!="bad.val")

system.library.HPPPMSMIntegration.integratePPM();

7. Repeat step 4 through step 6 for the cm.reject, cm.update.save, and cm.next.phase
processes.
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Verification

Note: This procedure is to verify that the implementation was done successfully.

The recommended way to verify this integration is to select/create a PPM task that contains
Service information as defined in "Associating UCMDB Service CI with PPM Entities" on
page 190.

To open an RFC from a PPM task to SM:

1. In PPM, navigate toSearch > Projects.

2. Search for and select your project.

3. In theProject Summary, click Edit Work Plan.

4. Go to theOperational RFC tab

5. Check the Create anOperational Request for Change (RFC) upon task save check box.

Requirement to Deploy Concept and Configuration Guide
Chapter 13: Creating an SM RFC from PPM Project Task

HP Value Stream (2.1) Page 226 of 256



6. Click Save. Confirm that there is a change ID received from SM and the update status is
Operational RFC has been successfully created.

7. Click theChange Number field in theOperational RFC tab and confirm that there is a change in
ServiceManager for this ID.

Note: TheService field in SM should contain the Service from the PPM task, and the
External Reference should contain the project ID from PPM.
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Chapter 14: Launching an OO Flow from SM RFC
This chapter includes:

Overview 228

Prerequisites 228

Adding anOperations Orchestration Integration 229

Enabling SSLConnection from SM to HP OO 232

Verification 236

Overview
This chapter describes how to launch HP Operations Orchestration (OO) flows from HP Service
Manager (SM), which enables you to provide quicker, more automated change processes, with the
ability to automate the deployment of a change. The SM –OO integration also provides the capability to
trigger OO flows within SM RFC and use SM record parameters in OO flows.

For more information, see Integration ID#408: LaunchOOFlow from SMRFC (SM –OO) in
HP Software Solutions Now.

The following diagram illustrates the relationship between the products for this integration:

Prerequisites
The following products must be installed.

l HP ServiceManager version 9.32 with Process Designer (PD) Content Pack

l HP Operations Orchestration version 10.02
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Reference Materials

l HP Service Manager Online Help Center. From the navigation pane, select System
Administration > Integrations.

Adding an Operations Orchestration Integration
This task adds and enables an HP OO integration in the ServiceManager Integration Suite (SMIS). It
specifies all parameter values required to set up the integration.

To add and enable a Service Manager to HP OO integration instance:

1. Log on to the ServiceManagerWindows orWeb client.

2. Navigate to Tailoring > Integration Manager.

Integration InstanceManager opens.

3. Click Add.

The Integration Template Selectionwizard opens.

4. Select SMOO from the Integration Template list.

Note: Ignore the Import Mapping check box, which has no effect on this integration.

5. Click Next.

The Integration Instance Information page opens.

6. Complete the following fields as necessary:

Field Value Description

Name
(required)

User-defined.
Default: SMOO

Name of the integration instance

Version
(required)

1.0 Version number of the integration

Interval
Time (s)
(required)

User-defined—for
example, 600

Polling interval (in seconds) for HP OO flow
synchronization
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Field Value Description

Max Retry
Times
(required)

0 (zero) Maximum allowed number of retries if the background
scheduler fails to run

Note: SMOOdoes not use this value.

SM Server Name that
identifies your SM
server host—for
example, sm_
host1

Display name for your SM server host

Endpoint
Server

Name that
identifies your
HP OO server
host—for
example, oo_
host1

Display name for your HP OO server host

Log Level
(required)

Select a level from
the drop-down list.
Default: INFO

Level of diagnostic information that the SM server logs to
the log file directory. Possible log levels are: DEBUG, INFO
(default), WARNING, ERROR, and OFF.

Log File
Directory
(required)

Specify a
directory—for
example,
c:\smoologs

Directory that exists on the SM server host where log files
of the SM toOO integration are stored. Log files are
generated in the following format: SMOO-
<yyyy><mm><dd>.log (for example, SMOO-20100328.log).

Note: If you specify a directory that does not exist, the
log files get lost. If you do not specify a directory, the
SM to HP OO integration does not work.

Run at
system
startup

Selected/not
selected

Automatically enable/disable the integration instance when
the SM server is started

Description HP OO flows
linked to SM

Description of the integration instance

7. Click Next.

The Integration Instance Parameters page opens.
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8. Click theGeneral Parameters andSecure Parameters tabs, andmodify the parameter values as
shown in the following table:

Parameter Value Example

oo.server.url Server address of HP OOCentral:

https://[servername]:[port].

Note that [servername] should be the fully
qualified domain name (FQDN) of the
HP OO server host.

https://oo.hp.com:8443

oo.user.name User name of the HP OO user account that
the SM server uses to access HP OO
Central to synchronize and launch HP OO
flows.

admin

oo.password Password of oo.user.name. admin

basepath.delimiter Delimiter betweenmultiple base paths. The
default delimiter is a semicolon (;).

;

basepath basepath1;bathpath2;...

The paths are separated by the base path
delimiter. Only the HP OO flows under the
base path and its sub-folders will be
synchronized from HP OO.

/Library/ITIL/Change
Management;/Library/
ITIL/Incident Management

Accept-Language Request Language Setting en

http.conn.timeout Http Connection Timeout setting (seconds) 30

http.rec.timeout Http Receive Timeout setting (seconds) 30

OOKM Set to true/false to enable/disable the
visibility of this integration instance in
KnowledgeManagement (default: true).

true or false

OOCM Set to true/false to enable/disable the
visibility of the HP OO integration instance
in ChangeManagement (default: true).

true or false

9. Click Next twice and then click Finish. Leave the Integration Instance Mapping and
Integration Instance fields settings blank. This integration does not use these settings.

ServiceManager creates the instance. You can edit, enable, disable, or delete it in Integration
Manager.

10. Enable the integration instance.
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Enabling SSL Connection from SM to HP OO
This task enables SSL connection between the SM andHP OO servers. The SM server acts as a
trusted client connecting to the HP OO server. This task creates a root CA and self-signed certificate in
the HP OO server and then imports them into SM.

Note:

l The following procedures are provided as examples, assuming that you have not changed the
security configurations of HP OO and SM since they were installed. Youmay need to adjust
the procedures depending on your specific security configurations in HP OO and SM.

l To perform the following procedures, youmust haveOpenSSL installed on your Operations
Orchestration Central host. In addition, youmust have a Java platform installed on the HP OO
and SM hosts.

l In the following procedures, <OO_HOME> represents the Operations Orchestration home
directory, and <SM_HOME> represents the ServiceManager home directory.

l The following procedure uses the Keytool utility that is located in <OO_HOME>
/java/bin/keytool. Add the path to PATH environment variable for ease of use.

Tip: Replace the parameters that are shown in angle brackets <XXX> with the location of the
keystore file and other personalized data on your computer.

To enable an SSL connection from SM to HP OO:

1. StopCentral and back up the original key.store file located in <installation
dir>/central/var/security/key.store.

2. Open a command prompt and execute the following commands:

c:\OpenSSL-Win32\bin\openssl.exe genrsa -des3 -out RSA_private.key 2048

a. Enter a pass phrase for RSA_private.key:<RSA_private.key>

b. Verify. Enter a pass phrase for RSA_private.key:<RSA_private.key>

This creates a file calledRSA_private.key in the current directory.

3. In same command prompt, run:

c:\OpenSSL-Win32\bin\openssl.exe req -new -key RSA_private.key -x509 -days 1095
-out <mycacert.pem>
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Here is the console output:

C:\sm-oo>c:\OpenSSL-Win32\bin\openssl.exe req -new -key RSA_private.key -x509 -
days 1095 -out mycacert.pem

Enter pass phrase for RSA_private.key:

Loading 'screen' into random state - done

You are about to be asked to enter information that will be incorporated into
your certificate request.

What you are about to enter is what is called a Distinguished Name or a DN.

There are quite a few fields but you can leave some blank

For some fields there will be a default value,

If you enter '.', the field will be left blank.

-----

Country Name (2 letter code) [AU]:IL

State or Province Name (full name) [Some-State]:Israel

Locality Name (eg, city) []:Yehud

Organization Name (eg, company) [Internet Widgits Pty Ltd]:HP Software

Organizational Unit Name (eg, section) []:PFS

Common Name (e.g. server FQDN or YOUR name) []:MYD-
VM08690.hpswlabs.adapps.hp.com

Email Address []:admin@operations.orchestration.com

This will generate themycacert.pem file in the current directory.

Caution:When asked for a CommonName, enter the fully qualified domain name (FQDN) of
the Operations Orchestration host. To create a unique .pem file, provide a uniqueOrganization
Name (for example, org1).

4. Execute:

keytool -genkey -alias sm -keyalg RSA -keystore "C:\Program Files\Hewlett-
Packard\HP Operations Orchestration\central\var\security\key.store" -storepass
changeit -keypass changeit -dname "CN=<MYD-VM08690.hpswlabs.adapps.hp.com>,
OU=<PFS>, O=<HP Software>, L=<Yehud>, ST=<Israel>,C=<IL>"

This generates a certificate key named sm and adds it to the key.store
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5. Execute:

keytool -certreq -keystore "C:\Program Files\Hewlett-Packard\HP Operations
Orchestration\central\var\security\key.store" -alias sm -storepass changeit -
file cert_request.crs

The result is the cert_request.crs file created in current directory.

6. Execute:

c:\OpenSSL-Win32\bin\openssl.exe x509 -req -days 1095 -in cert_request.crs -CA
mycacert.pem -CAkey RSA_private.key -CAcreateserial -out smcertificate.pem

Enter the pass phrase for RSA_private.key:RSA_private.key.

Note: This was the private key defined in step 2.

The smcertificate.pem file is generated.

7. Execute:

keytool -import -v -alias rootca -keystore "C:\Program Files\Hewlett-Packard\HP
Operations Orchestration\central\var\security\key.store" -storepass changeit -
file <mycacert.pem>

Confirm that certificate information is added into the keystore file.

Note: The ca certificate was provided a few steps back when it was generated after step 3.

8. Execute:

keytool -import -v -alias sm -keystore "C:\Program Files\Hewlett-Packard\HP
Operations Orchestration\central\var\security\key.store"-storepass changeit -
file <smcertificate.pem

Note: The file name of the sm certificate was generated in step 6.

9. Restart OOCentral service.

Once you have successfully configured SSL in HP OO, you are ready to configure SSL in SM.
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Create a trust store for SM:

a. Change to the following directory: <SM_HOME>/Server/RUN.

b. Copy the generated mycacert.pem and smcertificate.pem from <OO_HOME>\Central\conf
to <SM_HOME>/Server/RUN.

c. Run the following command:

keytool -import -v -alias rootca -keystore key.store -storepass changeit -
file mycacert.pem

The commandwindow displays the certificate information. The commandwindow prompts
Certificate was added to keystore.

d. When the commandwindow prompts Trust this certificate?, enter y.

e. Run the following command:

keytool -import -v -alias sm -keystore key.store -storepass changeit -file
smcertificate.pem

Note: In this example, the trust store file name is key.store, and its store password is
changeit. You will add this information to sm.ini in the next step.

10. Modify the sm.ini file to use the keystore for securing connections to HP OO by adding the
following lines.

#

# Certificates

#

truststoreFile:<key.store>

truststorePass:<changeit>

11. Restart SM Service.
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Verification

Note: This procedure is to verify that the implementation was done successfully.

To verify the integration:

1. Confirm that the base path in HP Operations Orchestration Central contains flows. In Service
Manager, the base path is stored as one of the properties of SM-OO integration instances. In the
following screen shot, the base path is /Library/Integrations.
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In the HP OO flow library, expand the base path and confirm that there are flows.

2. Log on to SM and create a Change record:

a. In the Change logging form, select theOO Flow links tab.

b. Expand theSelect Path drop-down box, and select the desired flow.

c. Click theAdd Link button.

A form to provide values for input parameters is displayed.
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Define the appropriate sequence number (for changes which require linkingmultiple flows) and
enter it in the appropriate field (sequence number). For a single flow, use 1. Click theAdd
button.

The HP OO flow is linked to the SM Change record.
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3. Execute the HP OO flow.

a. If No Automationwas selected when attaching the flow, forward the change record to the
Deployment phase (availability of this phase depends on the Change Category). While
viewing the change details, click theMore button and select Change Phase.

b. Select theDeployment phase and click Save.

c. Click theMore button, and select Execute OO flow. In the prompt, fill in the flow input
parameters and click Finish.
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After a while, the execution summary is displayed. Depending on the flow, it can end with the
status Resolved orError.

4. To review the results recorded inChange Updates:

a. InChange Details, select theUpdates tab and see the result of the flow stored within the
table.

b. Click the link on theDate/Time field to review the execution report.
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Chapter 15: Viewing Source Code and Build Data in
Agile Manager via ALI
This chapter includes:

Overview 241

Prerequisites 241

Setting Up the Agile Manager, ALI, and Third-Party Integration Configuration 242

Overview
Similar to the way HP Application Lifecycle Intelligence (ALI) is used to provide HP Application
Lifecycle Management (ALM) with the capability to access source code and build related data,
HP Agile Manager (AgM) also relies on ALI to provide those capabilities and enable the Agile Manager
user to view information about source code changes and builds in the context of Agile Manager user
stories and defects.

The following diagram illustrates the relationship between the products for this integration:

Prerequisites
The following products must be installed:

l Agile Manager account is enabled.

l SCM system is installed and running—for example, Git.

l Build system is installed and running—for example, Jenkins.
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Setting Up the Agile Manager, ALI, and Third-Party
Integration Configuration

Note: Agile Manager is an HP hosted product (SaaS), and is subject to continuous improvements
following user's feedback. Therefore, the instructions provided below may be quickly outdated.
Refer toAgM Online Help for themost current documentation.

To set up the Agile Manager, ALI and third-party integration configuration:

1. Download the ALI Dev Bridge component. From the Agile Manager interface, select Agile
Manager Configuration > Project > ALI Summary.

2. Extract the contents of the ALI Dev Bridge package on amachine which has network access for
Agile Manager instance as well as build server and SCM system.
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3. If the default port 8080 is not available, in <extracted Dev Bridge folder>/wrapper, modify the
wrapper-custom.conf file. The property value for –Dali.bridge.port=<insert free port number>
should be changed.

4. Using aWindows operating system, install ALI Dev Bridge as a service.

Using a command line, execute the DevBridge.bat script with install and then start parameters—
for example:
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5. Verify that ALI Dev Bridge is accessible, and log on using the Agile Manager credentials.
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6. In Agile Manager, edit the ALI Dev Bridge URL on the ALI Summary page.
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The status of ALI Dev Bridge should be connected now.

7. From the ALI Summary page in the Agile Manager configuration, download and install the Build
Management agent. It is a plug-in that allows Agile Manager to communicate with the build
management server.

Using Jenkins as an example, navigate to the Jenkins > Manage Jenkins > Manage Plugins >
Advanced tab, and then upload ali-jenkins-plugin.hpi.
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8. Configure the plug-in using Jenkins.

a. Log on to Jenkins as a user with administrative permissions.

b. In themainmenu, selectManage Jenkins, thenConfigure System in the openedmenu.

c. In theSystem Configurationmenu, scroll down to the ALI Integration section.

d. Fill in the Agile Manager system connection details: Agile Manager URL, Domain, Project
(can be inferred from the URL you use to access the Agile Manager environment), username
and password, as well as the name under which this Jenkins instance will be listed in the
Agile Manager environment.

e. Click the Test Connection button to validate successful connection to Agile Manager server.
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9. In the Agile Manager Project configuration, launch theALI Dev Bridge configuration wizard.
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10. Fill in the Build Management system details:
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11. Provide the required details about the application and release:
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12. Finalize by providing SCM details in the wizard:

The capability of Agile Manager to communicate with SCM and the Build Management system in order
to allow traceability between Agile Manager entities (User Stories and or Defects) and code changes
and builds is the result of the above actions. This can be seen in Agile Manager's Configuration page on
theALI Summary tab:
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Chapter 16: ALM Testing Tools
This chapter includes:

Overview 252

HP ALM Performance Center Testing Process 252

HP Unified Functional Testing 253

HP Sprinter 253

HP LoadRunner 254

Overview
Software testing is a broad discipline and HP offers multiple tools that cover various aspects of testing.
This chapter briefly describes those tools and provides references for additional information resources.

The tools mentioned in this chapter provide unique testing capabilities that can be used by ALM users
in order to runmanual and automatic tests written using various methods. For more information, see
page 552 in Chapter 31 of the HP ALM version 11.52 User Guide.

HP ALM Performance Center Testing Process
Using HP ALM Performance Center, you create performance tests to define the events that occur
during a testing session. During a test, ALM Performance Center replaces human users at physical
machines with virtual users—or Vusers. These Vusers create load on your system by emulating the
actions of typical users in a repeatable and predictable manner.

Each step in the testing process is carried out by one of the HP load testing tool components. The
components are as follows:

l HP Virtual User Generator (VuGen). Creates the script and generates virtual users—or Vusers.
VuGen does this by capturing actions that typical end-users would perform on your application, and
then records these actions into automated Vuser scripts. These Vuser scripts form the foundation
of a performance test.

l HP ALM Performance Center. Provides the central console from which you build, manage, and
monitor a test.

l HP Analysis. Analyzes the performance test and provides graphs and reports with in-depth
performance analysis information. Using these graphs and reports, you can pinpoint and identify the
bottlenecks in your application and determine the changes that need to bemade to your system to
improve its performance.
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Formore information on using PC and all of its components, see theHP ALM Performance
Center Quick Start Guide.

HP Unified Functional Testing
HP Unified Functional Testing's (UFT) combined solution for graphical user interface (GUI) and API
(service) testing enables you to test functionality across multiple application layers, such as the
front-endGUI layer, as well as back-end service layers. Additionally, the integrated BPT features
enable a wider range of both technical and non-technical UFT users, maximizing your opportunity to
create comprehensive automated tests.

For information on how to integrate UFT with ALM, see Part 5, "UFT IntegrationWith HP ALM" on
page 706 in theHP Unified Functional Testing User Guide.

HP Sprinter
You run tests manually from HP Application Lifecycle Management (ALM) using HP Sprinter. Sprinter
provides advanced functionality and tools to makemanual testingmore efficient and effective.

Manual testing often requires that you leave your testing application to accomplish tasks related to your
test. For example, youmay need to use graphic software to take a screen capture of your application,
youmay want to record amovie of the application during the test, or youmay need to switch to your
defect tracking software to report defects.

Sprinter enables you to accomplish these tasks without disrupting your test flow. With Sprinter, you
can also perform many of the repetitive and tedious tasks of manual testing automatically. Sprinter
includes many tools to help you detect and submit defects. These features ensure that you can perform
all the tasks necessary for your manual test with minimum interruptions to your testing work.

Sprinter also enables you to create, edit, andmanagemanual tests and business components directly
in Sprinter, and then save them to Application Lifecycle Management.

Sprinter is fully integrated with Application Lifecycle Management, enabling you to get themaximum
benefit from both solutions.

For more information on Sprinter's integration with ALM, see “Connect to Application Lifecycle
Management” on page 47 in theHP Sprinter Readme.
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HP LoadRunner
HP LoadRunner (LR) is the HP solution for application performance testing. LoadRunner stresses your
entire application to isolate and identify potential client, network, and server bottlenecks.

LoadRunner includes:

l HP Virtual User Generator (VuGen). HP's tool for creating Vuser scripts. You use VuGen to
develop a Vuser script by recording a user performing typical business processes. The scripts let
you emulate real-life situations.

l HP Controller. Allows you to easily and effectively control all the Vusers from a single point of
control andmonitor the scenario performance during test execution.

l HP Analysis. You use Analysis after running a load test scenario in the HP LoadRunner Controller
or HP Performance Center. The Analysis graphs help you determine system performance and
provide information about transactions and Vusers. You can comparemultiple graphs by combining
results from several load test scenarios or merge several graphs into one.

For more information regarding LR's integration with ALM, see “Working with Application Lifecycle
Management” on page 140 in theHP LoadRunner Virtual User Generator User Guide.
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Chapter 17: Execution of GUI and API Vusers as
LoadRunner Scripts for BPM
This chapter includes:

Overview 255

Installing and Configuring UFT and BPM 256

Overview
HP United Functional Testing (UFT) enables the creation of complex tests to examine the full spectrum
of your application's functionality and API.

In the HP Requirement to Deploy (R2D) Value Stream, after creating a test in UFT,you can run that
test automatically from HP Application Lifecycle Management (ALM) via the integration between ALM
andUFT.

You can use the tests created in UFT for testing purposes and also to createmonitoring scripts
combining the tests. This saves time by avoiding the need to rewrite themonitoring scripts from
scratch. The scripts can be added to the list of scripts in the HP Business ServiceManagement (BSM)
End-User Management module, as you would do with any script created with VuGen—LoadRunner's
script generation tool. You can then assign themonitoring scripts and execute them in an HP Business
Process Monitor (BPM) application configuration.

It is highly recommended to adjust the scripts for end-user monitoring purposes before using them in
BSM. This includes configuring SLAs, monitoring thresholds, editing or combining scripts to provide
better coverage of monitoring, and so on. For more information, see End-to-End ServiceMonitoring and
Event Management Best Practices.
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The following diagram illustrates the relationship between the products for this integration:

Installing and Configuring UFT and BPM
This procedure provides the capability to leverage UFT tests created during product development to be
used as BPMmonitors on the deployed service in order to validate that the critical functionality required
from the product is available for the end users.

To install and configure UFT and BPM:

1. Install UFT on a BPM server. For details, see Chapter 2, "Installing UFT" on page 12 in HP Unified
Functional Testing version 12.01 Installation Guide.

2. After the installation of UFT is complete, install BPM on the samemachine. For details, see
Chapter 6, "Installing BPM" on page 22 in HP Business Process Monitor version 9.24
Business Process Monitor Deployment Guide.

Note: During the installation, the BPMConfigurationWizard opens. The configuration for the
UFT – BPM integration is included in the BPMConfigurationWizard.

3. Configure the integration between UFT and BPM. For details, see "QuickTest Professional (QTP)
/Unified Functional Testing (UFT) Integration Page" on page 34 inBusiness Process Monitor
version 9.24 Deployment Guide.
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